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Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.

l Document Release Date, which changes each time the document is updated.

l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using themost recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport
ID, go to:

http://h20229.www2.hp.com/passport-registration.html

Or click theNew users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support
Visit the HP Software Support Online web site at:

http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed tomanage your business. As a
valued support customer, you can benefit by using the support web site to:

l Search for knowledge documents of interest

l Submit and track support cases and enhancement requests

l Download software patches

l Manage support contracts

l Look up HP support contacts

l Review information about available services

l Enter into discussions with other software customers

l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

To findmore information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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Chapter 1

Welcome to HP Service Virtualization
Welcome to Service Virtualization, HP's tool for simulating services during testing.

HP Service Virtualization software allows developers and testers access to limited or unavailable
services in a simulated, virtual environment. This helps application teams lower costs and reduce
testing times by finding defects earlier in the application life cycle when they are easier, faster, and
less expensive to fix. It helps improve quality by enabling quality assurance (QA) teams to test
what otherwise couldn't be tested. It also helps isolate problems that are based on dependencies
between services in composite applications. This helps significantly reduce delays andmanage the
costs and complexity of composite application development and testing.

This chapter includes:

l "How This Guide Is Organized" below

l "Service Virtualization Documentation" on next page

l "What's New in Service Virtualization" on next page

How This Guide Is Organized
This guide contains the following chapters:

Chapter Description

Chapter 1 "Welcome to HP Service
Virtualization" above

About this guide.

Chapter 2 "Getting Started" on page 13 Describes how to install and configure
Service Virtualization.

Chapter 3 "Virtual Services" on page 15 Describes what Virtual Services are and how
they are used.

Chapter 4 "SimulationModeling" on page 35 Describes how to use simulationmodels.

Chapter 5 "Composite Application Topology" on
page 60

Describes how to use the topology interface.

Chapter 6 "Supported Technologies And
Environments" on page 69

Describes how to install and work with
agents.

Chapter 7 "Service Virtualization Server" on
page 82

Describes how to access the Server.

Chapter 8 "Security" on page 84 Describes how to define security settings.
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Chapter Description

Chapter 9 "HP Test Automation Tools
Integration" on page 93

Service Test, Load Runner and Performance
Center integration.

Chapter 10 "Troubleshooting" on page 97 Suggestions for dealing with some issues
that may arise.

Chapter 11 "Service Virtualization Demos" on
page 104

A series of functional demonstrations.

Service Virtualization Documentation
Service Virtualization includes the following online documentation:

HP Service Virtualization Online Help. Available from the Service Virtualization user interface
by clicking in the window and pressing F1 or clicking theHelp button.

Printer Friendly Documentation. Online books can be viewed and printed using Adobe Reader,
which can be downloaded from the AdobeWeb site. To access, click www.adobe.com.

l HP Service Virtualization User Guide. can be accessed from HP Service Virtualization
2.10 > Documentation > User Guide from the Start menu.

What's New in Service Virtualization
What's New contains the following parts:

l "What's New in Service Virtualization 2.1" below

l "What's New in Service Virtualization 2.0" on next page

What's New in Service Virtualization 2.1
l Performance improvements

WithHP Service Virtualization Server 64-bit edition, the simulation performance is now
limited only by any limitations of your hardware. You can use an unlimited number of deployed
services, and simulate largemessages.

l Security additions

The enterprise environment sets high requirements for security features of deployed software.
HP Service Virtualization Server now adds Server Authentication, which restricts access to
server management and also encrypts communication between themanagement client (HP
Service Virtualization Designer) and the server.

l Functional improvements

Data Generators add dynamic data to simulation. Setting theSequential Number Generator
functionmakes each response unique by setting generated numbers to specific columns. The
Relative Date/Time function ensures that each date/time value is always up-to-date. Setting a

HP Service Virtualization (2.10)Page 10 of 105

http://www.adobe.com/


User Guide
Chapter 1: Welcome to HP Service Virtualization

delivery confirmation as "next week" will always return the “next week” date, unlike a fixed
recorded date.

What's New in Service Virtualization 2.0
l Enhanced support for service virtualization protocols

HP Service Virtualization 2.0 now supports a broad set of communication protocols.
Developers, functional and performance test engineers can quickly create or provision virtual
integration and test environments for Software as a Service (SaaS), Cloud andMobile
applications usingRepresentational State Transfer (REST) access protocol.

In addition, HP Service Virtualization 2.0 now supports the virtualization of IBM® WebSphere®
MQ systems to enable rapid delivery of new applications without the need to access high cost
production business systems. Now, users are able to continuously test applications depending
onmainframe systems without a need to wait for their availability.

HP Service Virtualization 2.0 also adds support forGeneric XML and Binary protocol
virtualization. It allows creation of virtual testing environments without a necessity of
understanding specific message structures. Generic XML allows virtualization of XML oriented
protocols with access to non-specific XMLmessages structure. Generic binary virtualization
allows simulation of any other protocol with access to text/binary representation of messages.

Another Service Virtualization 2.0 enhancement is support for protocols metadata. Users can
now very easily add, modify andmanage protocol headers or other transport dependent
information that must be used in creation of virtual servicemodels.

l Enhanced Virtual Services modeling

Ease of use and intuitive navigation is a key to any productive tool. HP Service Virtualization 2.0
introduces usability enhancements to Service Virtualization Designer. Enhanced Data Model
Editor allows easier navigation andmanipulation of learned, imported or entered data into virtual
servicemodels. It also introduces enhanced Virtual Service wizards with easy navigation and
filtering of out of the box and custom protocols. Data driven virtualization now support also
REST andMQ protocols.

Another addition is the new Service Description Learning and Editing. Service Virtualization
2.0 allows creation of Virtual Services without Service Description file (e.g. XSD schema) by
selecting non-service-description option in virtual service creation wizard. It also introduces
possibility to add schemas to already learned Virtual Services in generic virtualization or edit
structure of underlying Service Description.

Message oriented communication is very often asynchronous in its nature. Responses may be
in some cases delivered as a sequence of multiple messages. HP Service Virtualization 2.0
now adds support forMulti-response message simulation. Virtual services may now learn
and simulate responsemessages split to multiple parts (e.g. large documents), simulate real-
time process generating a series of responses (e.g. information stream) or transactions formed
as responses frommultiple subsystems (e.g. complex provisioning system).

Data driven testing is important for using pre-prepared test datasets, esp. when shared among
several tools. Service Virtualization 2.0 now adds support forData driving arrays and
choices. This completes set of message type constructs for which external data can be used.
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UsingServices Administration there is now possible to manage services of any connected
HP Service Virtualization Server, without necessity to open a project.

l Functional and technical improvements

Service Virtualization becomes a critical piece for agile application development and testing.
Demand for performance and scalability of service virtualization solutions grows as customers
start leveraging its benefits out of project teams across business units and enterprises. HP
Service Virtualization 2.0 introduces 15% improvements in performance of Service
Virtualization Server when comparing to previous version as well as enhanced support for
centralized deployments.
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Getting Started
This chapter includes:

l "Start Page" below

l "Updating Projects" on next page

Start Page
To start HP Service Virtualization, from theWindows Start menu, select All Programs > HP
Service Virtualization > Designer 2.10 > HP Service Virtualization Designer.

When you start the application, the Start Page opens.

The Start Page includes links to themost recent projects, links to common procedures, and a tab
for the installed sample projects.

See "How to Create a Virtual Service" on page 16

Select Close page after project load to close the Start Page as soon as you load a project.
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Select Show page on startup to show the Start Page on startup.

Updating Projects
Projects created in earlier versions of HP Service Virtualization are fully compatible with Service
Virtualization 2.10.

When opening an earlier project, a pop up window will inform you that the project contains
resources in an older format and ask you if you want to update them.

Click Yes to update your existing project.
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Virtual Services
Service Virtualization places a Virtual Service between the service under test and the real service
you want to simulate.

The Virtual Service uses the same service description as the real service. During Learning
Sessions, the Virtual Service passes the communication between the service under test and the
real service and records the service behavior and performance to the SimulationModel.

During Simulation Sessions, the Virtual Service does not pass the communication to the real
service, and instead returns responses and performance defined by the SimulationModel.

This chapter includes:

"Virtualization Explorer" on next page

How to use the Virtualization Explorer.

"Virtual Service Design" on next page

A description of themodes of Virtual Services.

"How to Create a Virtual Service" on next page

"How to Import Service Descriptions" on page 17

"How to Create REST Services" on page 21

"How to Create XML or Binary Services" on page 21

"Services Administration" on page 24

"How to Change Servers" on page 24

"How to Set Authentication Credentials" on page 25

"Virtual Service Editor" on page 26

A description of the Virtual Service Editor.

"Managing Virtual Services" on page 28

Learning and simulating services.

"Updating Virtual Services" on page 32

Changing service descriptions.

"Service Discovery" on page 33

A description of the service discovery tool.

"Service Templates" on page 33

A description of service templates.
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"Service Locking" on page 33

Dealing with locked services.

Virtualization Explorer
The Virtualization Explorer is initially the left hand pane of the application.

Open projects are presented in a tree format displaying the logical structure of the virtualization
project.

Click on an object in the list to display the details of the object in the lower pane.

Double-click an object in either pane to view a description of that object.

Right clicking on objects brings up the context menu allowing different options depending on the
object.

Virtual Service Design
The service virtualization process means creating virtual service endpoints. When you create an
endpoint you can reconfigure your client application to use this endpoint instead of the real service
endpoint. The purpose of the virtual service is to mediate between the client and the real service.
Service Virtualization allows you tomanipulate virtual services to get different results.

A virtual service has three basic modes- Learning, Simulating, and Standby:

l Learning mode: A virtual service can work as a proxy to record and learn the behavior of a real
service – it forwards real communication between a client and a service.

l Simulating mode: A virtual service is typically switched to a Simulatingmode. In this mode the
virtual service answers a client according to learned behavior and the real service does not
receive any communication.

l Standby mode: Real service responds to client requests.

How to Create a Virtual Service
Themost important step in simulating a service is the creation of a Virtual Service.

To Create a Virtual Service:

1. If no project exists yet, click Learn Existing Service orDesign Virtual Service in the Get
Started tab of the Start Page. If a project does exist, open the project context menu in the
Virtualization Explorer and select Add>Virtual Service to open the Import Real Service
Description dialog box.

Note: If no project exists, it is created with the creation of a new virtual service.

a. If you have a real service description available to import such as a SOAP service (.wsdl)
or an XML schema (.xsd), enter the file name, or click Browse to go to the file location
and click Start.
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i. If more than one Real Service Endpoint is detected in a SOAP service, you will have
to select which endpoints you require. If using an XML schema, select a transport
protocol and provide destinations.

ii. Click Next.

iii. Your selections are presented in the Summary Of Virtualization. Click Change to
alter your selections orVirtualize if your selections are correct.

See "How to Import Service Descriptions" below.

b. If you do not have a real service for import, select I don't have a service description and
click Start to open the Choose Service Protocol dialog box.

i. The available protocols are presented andmay be filtered by protocol type and
transport type. Click on the required protocol and fill in the details required for selected
protocol. See "How to Create REST Services" on page 21 and "How to Create XML
or Binary Services" on page 21.

ii. Click Next .

iii. Your selections are presented in the Summary Of Virtualization. Click Change to
alter your selections orVirtualize if your selections are correct.

Service Virtualization creates a new virtual service, a datamodel, and a performancemodel as part
of the virtualization project, and opens the "Virtual Service Editor" on page 26 view.

How to Import Service Descriptions
In order to virtualize a service, Service Virtualization needs to know what it does and what
endpoints it uses. Themost commonway to obtain this information is to import service description
documents.

Service Virtualization supports the following service description document types:

l WSDL

Web-Service Definition Language documents are themost commonway to describe SOAP
services. They often contain references to otherWSDLs and XSDs that must be available in the
referenced locations in order to import them and correctly describe the services they define.

For details, see "How to Import SOAP Service Descriptions" below.

l XSD

XMLSchema documents may also describe XML services. They often contain references to
additional XSDs that must be available in the referenced locations in order to import them and
correctly describe the services they define.

For details, see "How to Import XML Service Descriptions" on page 19.

How to Import SOAP Service Descriptions
Themost commonway to describe a SOAP Service is with aWSDL document. Service
Virtualization provides an import wizard that analyzes the content of theWSDL and enables you to
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associate it with a particular virtualized service.

To Import SOAP Service Descriptions:

1. Access the Import Real Service Description wizard in one of the following ways:

n During the creation of a Virtual Service. For details, see "How to Create a Virtual Service"
on page 16.

n In the Topology Editor view, virtualize a service that does not contain a service description.
For details, see "How to Create Virtual Services in Topologies" on page 65.

n In the Topology Tasks view, virtualize services that do not contain a service description. For
details, see "How to Virtualize Services in the Tasks View" on page 62.

n Open an existing project. From the Filemenu, select New > Virtual Service .

2. To select theWSDL specifying the SOAP Service, do one of the following:

n Input the path to theWSDL or use the browse button to find the location.

n Input the URLwhere theWSDL is exposed.

3. Click Start to process the selectedWSDL.

n If theWSDL describes multiple services or a single service specifyingmultiple ports, select
one from the list of available ports and click Next to proceed to the Summary of
Virtualization.

n If theWSDL only describes one service with a single port, the Summary Of Virtualization is
presented.

n If the description is for SOAP over JMS, a dialog will open allowing the change of the
destination name and the possibility of entering a reply to address.

4. Optional: Configure real and endpoint for virtual service if different from what is presented in
the Summary of Virtualization:

a. ForSOAP over HTTP(s):

i. Click Change under the Virtual Service description to open theChange Virtual
Service dialog.

The Virtual Service name, Agent type and Path can be altered. Click Save to save
changes orDiscard to go back to default values.

ii. Click Change under the Real Service description to open theChange Real Service
dialog.

The Real Service Endpoint can be altered. Click Save to save changes orDiscard to
go back to default values.

Note: If service is secured, youmust manage the credential store. For details, see
"How to Set Authentication Credentials" on page 25.

iii. When all values are correct, click Virtualize to create the service.

b. ForSOAP over JMS:
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Click Change under the Virtual Service description to open theChange Virtual Service
dialog.

i. Keep the default or rename the Virtual Service.

ii. Select different agent from the drop down list if required.

iii. Specify Destination Name (JNDI name) for virtual Destination endpoint.

iv. (Optional) If you are using a permanent Reply To destination, fill its JNDI name.
Otherwise, leave the field blank and a temporary Reply To destination is used.

v. Click Save to save changes orDiscard to go back to default values.

Click Change under the Real Service description to open theChange Real Service
dialog.

i. Check if theDestination Name, Reply To (blank if temporary Reply To is used) and
Connection Factory in the Change Real Service dialog have been pre-filled with
correct JNDI names. If necessary, change these values according to your JMS
configuration.

ii. Click Save to save changes orDiscard to go back to default values.

c. ForSOAP over TIBCO Enterprise Message Service™ (hereafter TIBCOEMS):

Click Change under the Virtual Service description to open theChange Virtual Service
dialog.

i. Keep the default or rename the Virtual Service.

ii. Select appropriate agent from the drop down list.

Click Change under the Real Service description to open theChange Real Service
dialog.

i. Check if Destination Name has been pre-filled correctly and change the values
according to your EMS configuration.

ii. Select aDestination Type from the drop down list.

iii. Click Save to save changes orDiscard to go back to default values.

5. Review the settings for the virtual service and click Virtualize to virtualize the selected
service, add the virtual service to the virtualization project, and put the virtual service in
Standby Mode.

How to Import XML Service Descriptions
To Import XML Service Descriptions:

1. Access Import Real Service Description in one of the following ways:

n During the creation of a virtual XML Service. For details, see "How to Create a Virtual
Service" on page 16.

n In the Topology Editor view, virtualize a service that does not contain a service description.
For details, see "How to Create Virtual Services in Topologies" on page 65.
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n In the Topology Tasks view, virtualize services that do not contain a service description. For
details, see "How to Virtualize Services in the Tasks View" on page 62.

n Open an existing project. From the Filemenu, select Add > Virtual Service.

2. Enter a path, a URL, or use the browse button to an existing XML schema (.xsd).

3. Click Start.

4. Select the required protocol and click Next.

Note: Protocols can be filtered by either entering text in the search field or using the provided
Protocol and Transport filters.

5. Select an input and output message type from the drop down lists and click Next.

6. Fill in the properties for the specific service:

XML over generic JMS:

Virtual Service

Destination name: JNDI name of destination where virtual service will expect requests.

Reply to: JNDI name of destination where virtual service will send responses. If the client
provides a ReplyTo JMS property, this field can be left empty.

Real service

Destination name: JNDI name of destination where real service expects requests.

Reply to: JNDI name of destination where real service sends responses. If this field is left
empty, the application will create a temporary destination for receiving response from the real
service and will set the ReplyTo JMS property in request to point to it.

Connection factory: JNDI name of connection factory to use.

XML over TIBCO EMS

Destination name: Name of destination where requests are sent.

Destination type: Type of destination where requests are sent.

Since Service Virtualization records messages on TIBCOEMS non-intrusively, all parameters
in the configuration are only related to the real service. At themoment when the virtual service
mode is switched to emulationmode, the real service is automatically disconnected from
TIBCOEMS and it is replaced by Service Virtualization.

There is no response destination name since the response destination is always read from
request properties.

XML over IBM® WebSphere® MQ

Virtual Service

Destination name: Name of queue where the virtual service should expect requests.

Reply to: Name of queue where virtual service will send responses. If the client provides a
ReplyToQueuemessage property, this field can be left empty.

Real service
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Destination name: Name of queue where real service expects requests.

Reply to: Name of queue where real service sends responses. If this field is left empty, The
application will create a temporary queue for receiving responses from the real service and set
the ReplyToQueuemessage property in the request to point to it. Note that WebSphereMQ
must be configured so that the application has permission to create temporary queues.

7. Click Next.

8. Your selections are presented in the Summary Of Virtualization. Click Change to alter your
selections orVirtualize if your selections are correct.

Note: If using and HTTP or HTTPS Gateway agent, the virtual servicemay have only one specified
endpoint.

How to Create REST Services
1. Access Import Real Service Description in one of the following ways:

n During the creation of a Virtual Service. For details, see "How to Create a Virtual Service"
on page 16.

n In the Topology Editor view, virtualize a service that does not contain a service description.
For details, see "How to Create Virtual Services in Topologies" on page 65.

n In the Topology Tasks view, virtualize services that do not contain a service description. For
details, see "How to Virtualize Services in the Tasks View" on page 62.

2. Select I don't have a service description.

3. Click Start.

4. Select the REST Service Protocol and click Next.

5. Enter the endpoint. If multiple endpoints are required, separated them with a space, comma,
semicolon or a new line and ensure that they are all for the same service.

6. Click Next.

7. Your selections are presented in the Summary Of Virtualization. Click Change to alter your
selections orVirtualize if your selections are correct.

How to Create XML or Binary Services
If you have an existing XML or binary service, it can be added to the simulation and if not, it can be
created from scratch. If the service is of an unknown type, creating a binary service is the best
solution. Even if Service Virtualization cannot understand themessage format, it can record it in
binary format, although it is not able to fully recognize the structure.

1. Access Import Real Service Description in one of the following ways:

n During the creation of a Virtual Service. For details, see "How to Create a Virtual Service"
on page 16.

n In the Topology Editor view, virtualize a service that does not contain a service description.
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For details, see "How to Create Virtual Services in Topologies" on page 65.

n In the Topology Tasks view, virtualize services that do not contain a service description. For
details, see "How to Virtualize Services in the Tasks View" on page 62.

2. Select I don't have a service description.

3. Click Start.

4. Select a binary messages type and click Next.

5. Fill in the properties for the specific service.

XML/Binary over HTTP

Endpoint: Supply Endpoints separated by space, comma, semicolon or a new line.

XML/Binary over Generic JMS:

Virtual Service

Destination name: JNDI name of destination where virtual service will expect requests.

Reply to: JNDI name of destination where virtual service will send responses. If the client
provides a ReplyTo JMS property, this field can be left empty.

Real service

Destination name: JNDI name of destination where real service expects requests.

Reply to: JNDI name of destination where real service sends responses. If this field is left
empty, the application will create a temporary destination for receiving response from the real
service and will set the ReplyTo JMS property in request to point to it.

Connection factory: JNDI name of connection factory to use.

XML/Binary over TIBCO EMS

Destination name: Name of destination where requests are sent.

Destination type: Type of destination where requests are sent.

a. Fill in the properties for the specific service:

XML over generic JMS:

Virtual Service

Destination name: JNDI name of destination where virtual service will expect requests.

Reply to: JNDI name of destination where virtual service will send responses. If the client
provides a ReplyTo JMS property, this field can be left empty.

Real service

Destination name: JNDI name of destination where real service expects requests.

Reply to: JNDI name of destination where real service sends responses. If this field is left
empty, the application will create a temporary destination for receiving response from the
real service and will set the ReplyTo JMS property in request to point to it.

Connection factory: JNDI name of connection factory to use.
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XML over TIBCO EMS

Destination name: Name of destination where requests are sent.

Destination type: Type of destination where requests are sent.

Since Service Virtualization records messages on TIBCOEMS non-intrusively, all
parameters in the configuration are only related to the real service. At themoment when the
virtual servicemode is switched to emulationmode, the real service is automatically
disconnected from TIBCOEMS and it is replaced by Service Virtualization.

There is no response destination name since the response destination is always read from
request properties.

XML over IBM® WebSphere® MQ

Virtual Service

Destination name: Name of queue where the virtual service should expect requests.

Reply to: Name of queue where virtual service will send responses. If the client provides a
ReplyToQueuemessage property, this field can be left empty.

Real service

Destination name: Name of queue where real service expects requests.

Reply to: Name of queue where real service sends responses. If this field is left empty,
The application will create a temporary queue for receiving responses from the real service
and set the ReplyToQueuemessage property in the request to point to it. Note that
WebSphereMQmust be configured so that the application has permission to create
temporary queues.

b. Click Next.

c. Your selections are presented in the Summary Of Virtualization. Click Change to alter your
selections orVirtualize if your selections are correct.

XML/Binary over WebSphere MQ

Virtual Service

Destination name: Name of queue where the virtual service should expect requests.

Reply to: Name of queue where virtual service will send responses. If the client provides a
ReplyToQueuemessage property, this field can be left empty.

Real service

Destination name: Name of queue where real service expects requests.

Reply to: Name of queue where real service sends responses. If this field is left empty, The
application will create a temporary queue for receiving responses from the real service and set
the ReplyToQueuemessage property in the request to point to it. Note that WebSphereMQ
must be configured so that the application has permission to create temporary queues.

6. Click Next.

7. Your selections are presented in the Summary Of Virtualization. Click Change to alter your
selections orVirtualize if your selections are correct.
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Note: If using and HTTP or HTTPS Gateway agent, the virtual servicemay have only one specified
endpoint.

Services Administration
The Services Administrationmodule enables you to view all services from configured servers,
without opening individual projects. All virtual services are displayed with their statuses, associated
models, and server locations.

To access Service Administration, click theService Administration link on the Getting Started
tab of the Start Page. The view can be filtered by server location.

The following options are available for services:

l Switchmodes:
n Switch betweenStandby andSimulatemodes.

n Switch from Learningmode toStandby orSimulatemode. When you switch from Learning
mode in Services Administration, the learning is stopped. The learned new data remains on
the server until the service switched to Standby or Simulate mode from within a project.

For details on virtual servicemodes, see "Virtual Service Design" on page 16.

l Change DataModel and PerformanceModel. When amodel is changed, an asterisk is
displayed next to themodel name, indicating that the change was not yet applied . To apply the
new model, the relevant service needs to be redeployed. This is done by changing its mode to
Standby or Simulate

For more details on Data and PerformanceModels, see "SimulationModeling" on page 35.

l To undeploy a service, click More Actions and select Undeploy.

l To unlock a service, click More Actions and select Unlock. For details, see "Service Locking"
on page 33.

Tomanage servers, from the Toolsmenu, select Options and then select theServers tab.
Alternatively, use the quick link from theMore Actions button at the bottom of the window and
selectManage Servers. The following options are available for servers:

l To add a server, click Add, provide the address of the server, and click Ok.

l To remove a server, select a server click Delete. Click Yes to confirm.

How to Change Servers
Tomove a project from one server to another server:

1. Right click the object in the Virtualization Explorer and select Change Server or from the
Project menu, select Change Server.

2. Select an existing server or enter the URL for a server and click Next.

3. Select agent from the drop down lists and click Finish.
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How to Set Authentication Credentials
Some services may require client authentication on either the transport or message level. When
virtualizing these services the application needs to know the client credentials used to connect to
the real service. The only exception is a scenario wherein a real service with HTTP transport
authentication (Basic, Digest, NTLM) is virtualized through the HTTP(S) proxy agent. In this
scenario, authentication requests are forwarded and the service virtualization doesn’t require the
credentials in the service’s credential store.

Prerequisites:

User of the Virtual Servicemust exist in the Local User Store of aWindows installation.

To Set Service Security Settings:

1. Access Security Settings in one of the following ways:

n From the Virtualization Explorer view, open the Editor view for a virtual service and expand
theSecurity Settings section.

n In the Topology Editor view, virtualize a secured service that does not have any
authentication set. For details, see "How to Create Virtual Services in Topologies" on page
65.

n In the Topology Tasks view, virtualize secured services that do not have any authentication
set. For details, see "How to Virtualize Services in the Tasks View" on page 62.

2. Tomodify the authentication credentials for a secured service, click Edit Credential Store
and do any of the following:

n To add user credentials:

i. Click Add Identity to open the Edit Identity Details dialog box.

ii. Input a Username and Password.

iii. Optional: Select Show Password to display the password in Security Settings.

iv. Optional: AddCertificate

v. Click OK to add the credentials to the Security Settings dialog box.

n To edit user credentials:

i. Select the user to edit, and click Edit Identity to open the Edit Identity dialog box.

ii. Input a Username and Password.

iii. Optional: Select Show Password to display the password in Security Settings.

iv. Click OK to change the credentials in the Security Settings dialog box.

n To remove user credentials:
o Select the user to remove, click Remove Identity, and confirm your decision.
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n To import credentials:

i. Click Import to open the Import Identities dialog.

ii. Select virtual service which contains identity you want to import.

iii. Select identity you want to import.

iv. Click OK to import the identity from selected virtual service.

n Save the Virtual Service.

Virtual Service Editor
The Virtual Service Editor enables you to control themode of the virtual service and themodels
currently in use, configure the endpoints, and configure any security settings.

Access the Virtual Service Editor in one of the following ways:

l In the Virtualization Explorer, double-click the Virtual Service you want to view or edit.

l In the Runtime View, click the name of the Virtual Service you want to view or edit.

l In the Topology Editor, open the context menu for the Virtual Service you want to view or edit
and select Open.

Virtual Service Editor

The Virtual Service Editor displays the following content and controls:
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Section Description

Virtual Service Name
and Description

The name and description of the Virtual Service (click to Edit).

Current Mode and
Models

The large icon displays whether the service is in Learning, Simulation,
Standby Mode or if the service is Offline. Below the icon, the Data and
PerformanceModels currently in use are displayed.

Virtual Service
Controls

Control Description

Put the service into LearningMode. Any
communication through the Virtual Service is added
to the SimulationModel in this mode. Use the drop
down arrow to select whichmodels to update:
l Data & Performance (default)

l DataModel

l PerformanceModel

Finish the current learning session and add any data
learned in the session to the SimulationModel.

Put the service into Standby Mode with the option of
maintaining or disposing of learned data.

Open the Runtime Report to display current
information about the service.

SimulationModels The SimulationModels section enables you to select which Data and
Performancemodels are in use andmanage themodels associated with
the Virtual Service.

EnableMessage
Logging

The checkbox toggles logging. Themessages are stored on disk in the
Designer log directory %TEMP%\HPServiceVirtualizationLogs.
Messages processed by the embedded server are stored in the sub-
directory msg-embedded\[Virtual Service Name]. Messages
processed by the standalone server are stored in the sub-directory msg-
standalone\[Virtual Service Name] on the standalone server
itself. Eachmessage is stored in a single file named [Message Order

Number]-[Message Id].

Service Configuration Displays the endpoints for the Virtual Service with options to copy these
details to the clipboard. Click Edit to change the endpoint details.

Agent Displays the agent selected for the service. If using the embedded
server, click Configure to change the agent settings. For details, see
"Supported Technologies And Environments" on page 69. If using a
standalone server, click configure to see documentation regarding
agents.

Virtual Service Editor Content
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Section Description

Service Description Displays service descriptions and any metadata associated with the
service. Click Edit to add new operations or updatemetadata. Click
Update From File to update the service description.

Security Depending on protocol, displays any credentials used to access the
service with management options. Click Edit Credential Store to
modify credentials. For details, see "How to Set Authentication
Credentials" on page 25. For Message Security, select Enabled to apply
settings. For details, see "How to Set Message Security" on page 86.

Managing Virtual Services
The Virtual Services in the virtualization project can bemanaged in several ways:

l Switching between the simulation and standby modes, passing the control to the real service
without reconfiguring clients.

l Activating learningmode where the real service responds and the selected data and/or
performancemodels of virtual service get updated.

l Managing all services at once in the runtime view and changing the runtime where the virtual
services run (i.e. from an embedded to a standalone server).

This section includes:

Learning Service Behavior 29

Simulating Services 29

Runtime View 30

Problem List 32
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Learning Service Behavior
Real services may not be available on a permanent basis due to cost, access, or if different model
is required.

After a Virtual Service is created, the behavior of the real servicemust be recorded in order to see
the requests and responses of the real services.

Once this behavior is captured by Service Virtualization, it can be used to create data and
performancemodels.

For details, see "How to Learn Services " below.

How to Learn Services

Prerequisites:

l Create a virtual service. For details, see "How to Create a Virtual Service" on page 16.

l Optional: Select the Data and PerformanceModels to record to. For details, see "How to Select
Models" on next page.

1. After a virtual service is created, it is displayed in Standby mode by default. Clicking on Learn
stops or starts the learningmode. Click the arrow next to the Learn button to select the data
model, the performancemodel, or both.

2. Run the application communicating with the real service. All service calls are recorded.

3. When you have enough recordedmessages, click theStop button to stop the learning
process. The simulationmodel updates with the recorded data.

Simulating Services
The virtual service can use both the data and performancemodels for the simulation or use them
individually.

Data Simulation Options

It is possible to simulate learned responses by selecting one of the datamodels. It is also possible
to turn the data simulation off and let the real service respond, and thereby simulating only the
performance using one of the performancemodels.

See "DataModel" on page 36

Performance Simulation Options

It is possible to simulate learned or customized performance by selecting one of the performance
models.

See "How toManageModels" on page 36

It is possible to turn the performance simulation off by selecting theNone performancemodel. The
response times are not affected by any model and the virtual service responds as fast as possible.
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It is also possible to simulate the absence of the service by selecting theOffline performance
model. The virtual service does not respond back to the client in this mode.

"How to Select Models" below

"How to Start Simulations" below

How to Select Models
Before you start a learning or simulation session, you can select which Data and Performance
Models you want to associate with each Virtual Service.

Prerequisites:

l Create a virtual service. For details, see "How to Create a Virtual Service" on page 16.

l Optional but recommended: Record the performance of the real service. For details, see
"Learning Service Behavior" on previous page.

l Optional: Edit the Data and PerformanceModels. For details, see "SimulationModeling" on
page 35.

To Select a Data or Performance Model:

1. In the Virtualization Explorer, click the virtual service name to open the Virtual Service Editor.

2. The SimulationModel section shows the available models for the Virtual Service. Select your
models.

Models can be added, edited, or deleted from the Virtual Service using the associated buttons. For
details, see "How toManageModels" on page 36

How to Start Simulations

Prerequisites:

l A simulationmodel must already exist. For details, see "How to Learn Services " on previous
page

1. From the virtual service page, click theSimulate button to start simulation of a real service.

2. Run the application communicating with the original real service.

Runtime View
The Runtime View provides an overview of all the Virtual Services in your Virtualization Project and
the functionality to control them. During a learning or simulation session, the Runtime View
provides an overview of the communication through the Virtual Services.

Access the Runtime View using theView > Runtime Viewmenu option.
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The Runtime View displays a table of all the Virtual Services in your project with the following
options and information for each service:

Column Description

Selection Boxes Select services and apply the controls under Virtual Service Controls in the
"Virtual Service Editor" on page 26.

Virtual Service
Mode

Displays whether the services are in Learning or SimulationMode with an
option to filter the table.

Virtual Services Click the service name to open its editor.

Problems Indicates any problems which occurred during the learning or simulation.

Messages /
Unique

Indicates the number of messages and uniquemessages passed through the
Virtual Service during the current learning or simulation session.

DataModel
(Accuracy)

Indicates the DataModel currently in use and its accuracy during simulation.

Performance
Model
(Accuracy)

Indicates the PerformanceModel currently in use and its accuracy during
simulation.

Project Displays the name of the Project to which the Virtual Service belongs.

Runtime Display

The Runtime View contain the following controls:

Control Description

Put the service into LearningMode. Any communication through the Virtual
Service is added to the SimulationModel in this mode. Use the drop down arrow
to select whichmodels to update:

l Data & Performance (default)

l DataModel

l PerformanceModel

Finish the current learning session and add any data learned in the session to the
SimulationModel.

Put the service into Standby Mode with the option of maintaining or disposing of
learned data.
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Control Description

Info Located in theMore Actionsmenu. Open the Runtime Report to display current
information about the service.

Unlock Located in theMore Actionsmenu. Used to unlock a blocked service. See
"Service Locking" on next page.

Problem List
The Problem list displays problems that occurred during the application or server run. The source of
problems can be either runtime errors in the application or a problem occurring during a service
lifecycle ie: deployment/ standby/ learning/ simulating.

Column Description

Problems Filters different problem types. Error/ Warning/ Information

Type Problem Category and number of occurrences.

Fix It Some problems can be resolved with user interaction. These contain a Fix It link to
the part of the UI that may be source of the problem.

Source
Filter

Filters problems for a specific service call.

Description A description of the problem.

Time Time and date of problem occurrence.

Updating Virtual Services
After a virtual service is created youmay need to update the service description.

To update the service description:

1. Right click the service in the Virtualization Editor and select Update Service Description. If
the service is not locked (see "Service Locking" on next page), the wizard starts.

2. Enter the path or URL, or use the Browse button to enter the new WSDL. Click Next.

3. The designer now examines the new description and displays the supported and unsupported
transformations. If there is an unsupported transformation, the update stops and theWSDL
must be altered. If all transformations are supported, click Finish to apply the update.

Note: In some cases, the designer may prompt the reloading of open editors.
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Service Discovery
Service Discovery can be used to find all services used by an application via a proxy gateway. It
can only be used in the case of an embedded server.

To use Service Discovery:

1. Either create a new Service Discovery Project through theNew Virtualization Project
Wizard or right click in the Topology view of an existing project.

2. Select the server and proxies.

Note: The client applicationmust be using the Service Virtualization proxy before attempting to
find services.

3. Click Run Service Discovery.

4. When Services are discovered, click Stop Discovery to continue with the project. Discovered
services are presented in a grouping called Discovered Services and can be used in the
topology. For details, see "How toModel Composite Applications" on page 60.

Service Templates
Service Templates can be created in order to:

l Reuse Virtual Services in multiple testing environments.

l Reuse configuration, custom functions, data and views.

Note: Service Templates can be created by Professional services with complex functionality.

To save a service as a template:

1. Right click the service in the Virtualization Explorer and select Save As Template.

2. Give the template a name and specify the location.

3. Click Save.

Service Locking
A Designer or a test emanating from HP LoadRunner / HP Service Test may require indicating that
they own a virtual service (start session) or that virtual service is free (stop session) in order to
prevent conflicts. They may also need to know who is the present owner of a service as a service
can be only owned by one client at a time. A servicemay be locked by the owner and other clients
can see who the owner is as each client has a unique “client ID”.

When a service is locked then its configuration and all its Data and Performancemodels are also
locked. The owner of the service canmodify the service and its model, but other clients are not
allowed. If a user tries tomodify the service or its model then the UI displays that the service is
locked and which client is the owner of the service. If a Designer or a test is the owner then
modification is allowed.

If a service is locked, the followingmessage is displayed :
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If a technical problem occurs or a test runs too long, you can force an unlock in Designer. The
actionUnlock can be found in theMore Actionsmenu in theRuntime View.

Note: No changes are allowed to a service and its models during the learning process. This process
must be completed regardless of the owner of the virtual service. Unlock is not available
during this time.
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Simulation Modeling
Themost important part of Service Virtualization are the SimulationModels. SimulationModels are
one of the followingmodel types:

l Data Model

TheData Model enables you to record actual requests and responses for the real service and
then use this data for simulation using the Virtual Service. You can edit the datamodel from
scratch or add to recorded data, add service calls, andmodel stateful behavior. This enables you
tomodel the interaction between the service under test and the simulated service tomeet many
integration test cases. For details, see "DataModel" on next page.

l Performance Model

The PerformanceModel enables you to record the performance for the real service and then use
this as amodel for the Virtual Service. You can customize the performance criteria of themodel
to meet many performance use cases. For details, see "PerformanceModel" on page 53.

When you create a Virtual Service, Service Virtualization creates a DataModel and Performance
Model associated with it. Thesemodels serve as the default models for Learning and Simulation
Sessions. For details, see "How to Create a Virtual Service" on page 16.

You can associate each Virtual Service with multiple customizable Data and PerformanceModels.
For details, see "How toManageModels" on next page

Prior to a Learning or Simulation Session, you can select which Data and PerformanceModels to
use, including additional non-customizable options. For details, see "How to Select Models" on
page 30.

Eachmodel is customizable, enabling you to perform simulations that meet specific test use
cases. For details, see "How to Edit DataModels" on page 44" and "How to Edit Performance
Models" on page 56.

Also see:

"DataModel Editor" on page 38

A description of the DataModel Editor.

"PerformanceModel Editor" on page 54

A description of the PerformanceModel Editor.

"Service Description Editor" on page 57

A description of the Service Description Editor.
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How to Manage Models
By default, each Virtual Service is associated with one datamodel and one performancemodel,
which are created with the Virtual Service. Additional models can be associated with a Virtual
Service.

Prerequisites:

l Create a virtual service. For details, see "How to Create a Virtual Service" on page 16.

To Manage Models:

1. From the Virtualization Explorer, open the Editor view for a Virtual Service.

The Virtual Service Editor displays a SimulationModel section showing the Data and
PerformanceModels associated with the Virtual Service. Each type of model has Add, Edit,
andDelete actions associated with it.

Note: None andOffline are not actual models. They are options available for simulation
purposes. None for DataModel messages are passed to the real service and its
responses are sent back while still simulating the performance according to the selected
PerformanceModel. None for PerformanceModel makes the Virtual Service respond as
fast as possible. OfflinePerformanceModel simulates the unavailability of the service.

2. For either DataModels or PerformanceModels, do any of the following:

n To Add a New Model:

i. Click the relevant Add link.

ii. Input a name for the new model, and optionally for PerformanceModels, select to copy
the performancemetrics of the currently activemodel.

iii. Click OK to add the new model to the relevant set of models.

n To Edit a Model:

o Select themodel you want to edit, and click the relevant Edit link to open the DataModel
Editor or PerformanceModel Editor view.

For details, see "DataModel Editor" on page 38 and "PerformanceModel Editor" on page
54.

n To Delete a Model:

o Select themodel you want to delete, click the relevant Delete link, and confirm your
decision.

3. Save the Virtual Service.

Data Model
The DataModel enables you to customize the requests and responses, and service call activity of
a service during simulation.
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When you create a Virtual Service, Service Virtualization creates a DataModel associated with it.
For details, see "How to Create a Virtual Service" on page 16.

Each Virtual Service can havemultiple DataModels. For details, see "How toManageModels" on
previous page.

Prior to recording or simulation you can select whichmodel to use, including selecting to use the
real service. For details, see "How to Select Models" on page 30.

This model is then available to learn the data behavior of the real service and can be customized to
set specific data rules for its individual operations.

Data Rules

Themain part of the DataModel consists of a set of Data Rules for each operation in the service.
The following types of rules are available:

l Learned Data Rule

The Learned Rule displays the requests and responses from Learning Sessions. In general, you
do not customize this data but youmay want to set conditions to ignore parts of the requests and
responses and add service call activity.

l Default Response

The Default Response provides a single custom response to apply in cases where there is no
other data, or where you want to ignore specific parts of recorded response data.

l Custom Rules

Custom Rules enable you to set custom responses and service call activity to specific requests
enabling you to perform various testing use cases.

l External Rules

External Rules are used to bind request and response data from external data source that can be
used by several applications or exported from external applications like HP Service Test, HP
LoadRunner or HP QuickTest. The data source can be edited by an external application and then
the data can be refreshed in the DataModel.

You can set the priority order of multiple rules tomeet various simulation testing use cases.
Generally, the following order applies:

1. Custom or External Rules to provide specific responses and service call activity for the
purpose of testing specific service behavior.

2. Learned Data Rule to provide typical responses and service call activity of the real service.

3. Custom Rules to provide responses and service call activity for requests that cannot be
recorded or have not been recorded yet.

4. Default Response to provide a single generic response or generic parts of response data where
other rules do not apply.

Service Call Activity

In many cases, the simulated service can call another service to perform some particular operation
or to receive some additional data. Virtual Services can simulate this behavior by adding Service
Call Activity to an operation. You can define static request data for the Service Call Activity for any
row in the rule or use the Copy From function to copy data from the Virtual Service request or from
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the response of another Service Call Activity. If a called service also has a response, you can use
the Copy From function to copy some response data from a service call activity to a Virtual Service
response. For more details, see "How to Add Service Call Activity" on page 50.

Tracks

The other main feature of the DataModel are Tracks that determine the order of the simulated
service behavior.

In many test cases, the order of requests is important because a servicemay return different
responses for the same request depending on the current state of the service. Service Virtualization
enables you to simulate this stateful behavior using Tracks. Tracks enable you to construct
sequences of requests and responses in the DataModel for the service. During a simulation
session, Service Virtualizationmoves along the Tracks according to test requests that match the
requests in the track and returns the appropriate response. For example, if the simulated service
can return an approve or deny response which is determined by a particular state of the service, you
can determine which response to return by specifying the sequence of requests and responses in
the track. For more details, see "How to Edit DataModels" on page 44

Import Messages

New rows can be added to a rule by learning new data, by adding a new row andmanually editing its
cells or by importingmessages.

Importingmessages is useful in the case when it is not possible or it is difficult to learn
communication between a tested application and a simulated service directly, but it is possible to
listen to the communication and log transportedmessages via another tool. ImportingMessages is
available in the DataModel Editor from the context menu of the rules data table (only for Custom
and Learned Rules). It is possible to import a request and/or response part of themessage in the
same format as it is sent via communication protocol from a clipboard or from a file. If a message is
imported from a file, the file can contain just request or response part of onemessage. For more
details, see "How to Add Data Sources" on page 50 .

Multi Response

In addition to the simple simulation of a request-response pattern, when some operations are
marked one-way, Service Virtualization is able to simulate a request-response pattern where 0 to n
responses are given per request.The number of responses can differ according to the state of the
service and can be changed in the DataModel Editor. Service Virtualization permits the learning
and editing of a different number of responses, their types and the state of the services (whichmay
affect both the data in the response as well as their number). Multi Response can be used in
templates, functions and custom functions, generation of responses frommultiple rules, data
driving, and activities. The performance simulation is limited to the learning and simulation of the
response time of the first response. These features are available on both standalone and embedded
servers. The supported protocols are XML and binary services overWebSphereMQ and JMS.

Data Model Editor
The DataModel Editor enables you to configure requests and responses, and service activity calls
for individual operations of a Virtual Service during simulation.

Access the DataModel Editor in one of the following ways:
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l In the Virtualization Explorer, double-click the DataModel you want to view or edit.

l In the Virtual Service Editor, in the DataModel section, select themodel you want to view and
click Edit.

The DataModel Editor opens for the selectedmodel showing details at the operation level.

Data Model Editor Overview

1. Name of datamodel which can be edited in place.

2. Description of datamodel which can be edited in place.

3. List of operations for the virtual service associated with themodel.

4. List of global rules. A global rule exists across all operations for the virtual service.

5. The rule Learned Data contains learned data. It displays the requests and responses learned
during the learning state of a virtual service. In general, you do not customize this data but you
may want to set conditions to ignore parts of the requests and responses for performance
testing and add service call activity.

6. The ruleDefault Response provides a single custom response to apply in cases where there
is no other data for a given column or where you want to ignore specific parts of recorded
response data.

7. Number of rows in the global rule across all operations.

8. Toolbar with action buttons.
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9. Element filter.

Custom Rule

1. Selected operation.

2. Custom rule.

3. Name of the rule. Click to edit.

4. Description of the rule. Click to edit.

5. Action button to change the priority of a custom rule. The priority of the custom rule can be
increased or decreased.

6. The term 1/1 rows indicates that the global ruleNew Rule 1 contains one row across all
operations and one row for the selected operation in this rule.

7. Priority of the rule. Priority is from 1 to n. 1 is the highest priority.

8. Row with conditions for data columns. Use the drop down controls for each column to control
the condition to be applied to the data.

9. Row with data.

10. Request column header.

11. Response column header.

12. Action to collapse wholemessage section. For example a request, a response or a service
activity call.

Stateful View
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1. Track Position column contains information about how rows are used in a stateful simulation.
This information is represented by an association with a given track and a position in that track.

2. User can see how the given call (request/response pair) is used during a stateful simulation.
User can use Add to Track to insert the given call into a sequence of calls in track on a
position.

3. Name of track which can be edited in place.

4. Sequence of calls in displayed track.

5. One call of given operation in a sequence of calls for the track.

6. Selected call of a given operation. The associated row for the call is selected in the table and
its rule is opened.

7. List of all tracks whichmodel stateful behavior. This list can be filtered by the current opened
rule.

8. Button to create a new track tomodel stateful behavior.

9. Button to delete selected/displayed track.

Rule button menu

Blank Rule - Create a new global rule with an embedded data source. The global rule exists across
all operations.

Data Driven Rule - Use an external file, i.e.: MS Excel, as a data source for a rule. A new read-
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only rule is created for this data source. This action opens theUse Existing Data Source dialog
allowing the user to reference anMS Excel file as a data source with the options of using the first
row for column names.

See "How toManage Rules" on page 45.

Operations/Uri Spaces button menu

Browse and Search Operations/Uri Spaces - opens/closes left pane with operations/uri spaces
list - this pane will require its own chapter as well as there is additional functionality.

Edit Operations/Uri Spaces - opens service description editor allowing tomodification of
operations/uri spaces, their data formats andmetadata.

Recently Used Operations - a list of themost recently used operations for quicker access.

See "Service Description Editor" on page 57.

Columns button menu

Change Columns - Opens Change Columns dialog. This dialog is used to configure table column
visibility. See "Changing Columns" on page 44.

Flat Headers - Toggles between flat and structured column headers.

Structured Headers - Toggles between flat and structured column headers.

Activity button menu
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List of imported services whose operations can be used as a service call activity.

Import Activities - Import a service description of a service whose operations can be later used as
service call activities.

See "How to Add Service Call Activity" on page 50.

View Options button menu

Functions - Displays the row with conditions for data columns.

Data Binding - Display row with binding to a data source in rules, i.e:MS Excel file. Binding is only
visible for rules which are connected to an external data source.

Time Stamp - Displays the column in rules. This column contains the time of creation or last
modification.

Multi Response - In the case that response data contains more than one response, these are
presented. For details, see "DataModel" on page 36

Stateful View - Displays theTrack Position column in rules and the Track View.

Operations - Toggles the display of individual operations in the left hand pane.

Simulation Preview - displays in real time how changes in the DataModel are affecting the
simulation.

Full Screen - Switches theData Model editor to the full screen view.
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Changing Columns
The Change Columns Dialog is accessed by clicking theColumns button in the Data Editor and
selectingChange Columns, using the hot key Ctrl+M or by accessing the context menu on a rule.
Themain function is to toggle the visibility of structured columns in the data table of a rule by
selecting checkboxes corresponding to the required view.

Columns are presented in a tree format and context menus are available allowing easy navigation
within large structures.

Columns can be filtered using by entering text in the search field. Arrows on the right of the filter
fields provides navigation between found results and clicking x clears the filters text.

A header selected in the Change Columns window will be highlighted in the open table.

Note: Changes in columns visibility are applied immediately. Changes can be reverted by clicking
Cancel and confirmed by clickingOk.

How to Edit Data Models
Each virtual service is associated with at least one datamodel which can contain the recorded
behavior of the service and also customized data for simulation. Each datamodel contains a set of
Rules defining data behavior for each operation in the service and Tracks to determine the order of
stateful behavior. For more details about the DataModel, see "DataModel" on page 36.

Prerequisites:

l Create a virtual service. For details, see "How to Create a Virtual Service" on page 16.

l Optional but recommended: Record the behavior of the real service. For details, see "How to
Learn Services " on page 29

To Access the Data Model Editor:

l Do one of the following:

n In the Virtualization Explorer, double-click the DataModel you want to edit.

n In the Virtual Service Editor, select the DataModel you want to edit, and click Edit.

The DataModel Editor opens displaying the Rules and Tracks for themodel. For UI details, see
"DataModel Editor" on page 38.

To Change the Model Name or Description:

1. Click the name tomake the name and description editable.

2. Input the new name and description.

3. Hit Enter to commit your changes.

You can edit various aspects of the DataModel. For details, see the following sections:
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l "How toManage Rules" below

l "How to Add Data Sources" on page 50

How to Manage Rules
Rule Function fields are used to give column datameaning. Setting a function to the column directly
modifies the behavior of the simulation. Functions are set on a per column per operation principle.
They can be split into two parts:

l Condition functions: Is, Ignore, Compare Ordered, Compare Unordered, and Custom Condition
Functions

l Action functions: Set, Copy From, Replace Array, and several Data Generator functions (see
below)

The default function for all columns is Ignore: the value does not influence the simulation in any
way. Functions can be applied to various levels of a data line. Learned data rules are set as is
function on requests and set function on responses.

When the simulation is in progress, the simulator engine walks through the rule according to rule
priorities attempting to find a single line (from each rule) that most precisely conforms to the
condition functions used. When a single data line is selected, all the action functions are applied to
that data line.

Data Generator Functions
Data generator functions are used to generate dynamic data in certain elements of the responses.
There are three types of data generators:

l Sequential number generator. Used to generate a series of increasing/decreasing numbers in
a specified format. The number increases/decreases by a predefined value with each received
request.

l Set relative date time. Used to generate a date and/or time that is relative to the time of the
request arrival. For example: time of request arrival plus 2 hours and 5minutes.

l Set date time relative to. Used to generate a date and/or time that is relative to a date/time that
is stored in any element of the request. For example: time stored in a certain element minus 3
days and 5 hours.

This section includes:

l "Sequential Number Generator Function"

l "Set Relative Date Time Function"

l "Set Date TimeRelative To Function"

l "Offset Format Specification"

l "Date/Time Formatting Used in Set Date Time Functions"

Sequential Number Generator Function
Each cell under this functionmust contain a value in this the following format:

Offset;Increment;FormatString
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where:

l Offset is an integer

l Increment is an integer (positive or negative)

l FormatString is a regular text string that contains zero or more special sequences. Each of these
sequences starts and ends with the '#' character. The output of the generator is defined by going
through the FormatString and constructing an output string using these rules:

n Any characters that are not part of the special sequence are copied to the output string.

n For each empty special sequence (i.e. there are two ‘#’ characters next to each other), a
single ‘#’ character is inserted into the output string.

n Each non-empty special sequencemust contain one or more ‘D’ characters. These
characters act like a digit wildcard for a number that will be generated by this generator
function. The number will always occupy exactly the number of specified digits.

Examples of the cells' values:

l 10;1;NUMBER:###DDDDDD#-000

l 89;-5;test;DDD;###D###

l 2;-3;1256#DDDDDD#-867

l 121;-25;#DDD#-##-#DD#

To generate a sequence of numbers that differs for each request/response, each cell with this
generator function has an internal numerical counter. When the simulation starts, this counter is
always set to 0. Each time a generator function is called, the value (Offset + Counter) is used for
the purposes of number formatting of each special sequence found in the FormatingString (see
below). After the output is determined, the value of the Counter is increased by the value of the
Increment (or decreased, if the Increment is a negative number).

Formatting the special sequence:

Each special sequence consists of a number of 'D' characters. The value (Offset + Counter) needs
to be stored as a number that has exactly as many digits as there are 'D' characters in the special
sequence:

l If the number does not occupy all digits, zeros are added before it so that it does.

l If the number is greater than themaximal number that can be stored within the digits, it is
truncated so that it fits within (e.g. if the number was 3456 and the special sequence was
#DDD#, the output will be 456).

l If the number is negative, it is truncated the sameway as above. Then an additional offset is
applied. The value of this offset is based on the number of digits and is selected so that -1
becomes the biggest number that fits within these digits. For example, if the special sequence
was #DDDDD#, -1 becomes 99999. If it was #DD#, -67813 becomes -13 which then becomes
87.

Examples of the cells' values:

l '10;1;NUMBER:###DDDDDD#-000' generates: 'NUMBER:#000010-000', 'NUMBER:#000011-
000', 'NUMBER:#000012-000' ...
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l '89;-5;test;DDD;###D###' generates: 'test;DDD;#9#', 'test;DDD;#4#', 'test;DDD;#9#', ...

l '2;-3;1256#DDDDDD#-867' generates: '1256000002-867', '1256999999-867', '1256999996-867',
...

l '45121;-25;#DDDDD#-##-#DD#' generates: '45121-#-21', '45096-#-96', '45071-#-71' ...

Set Relative Date Time Function
TheSet relative date time function stores a Date and/or Time value in the element that is
calculated by adjusting a date/time when the request was received by a predefinedOffset. The
Offset is obtained from the cell. If the Offset is not specified for a particular cell or is in an incorrect
format, 0s (0 seconds) offset is used. For information about the format of the Offset, see "Offset
Format Specification" below.

The resulting date/time that will be put in themessage is formatted according to the xsd type of the
element. It can also be custom formatted. In that case, the cell with the custom format must
contain the Offset, followed by a '#' character, followed by the Custom format specification (For
example, -1:25:00#hh:mm).

For more information about the formatting according to xsd types and custom formatting, see
"Date/Time Formatting Used in Set Date Time Functions" on next page.

Set Date Time Relative To Function
TheSet date time relative to function stores a Date and/or Time value that is calculated in the
element by adjusting a specified date/time by a predefinedOffset. Instead of adjusting the
date/time of themessage arrival, this function requires the user to select a source element
containing the date/time to be adjusted. Other than that, it works like the "Set relative date time"
function. TheOffset is obtained from the cell. If the Offset is not specified for a particular cell or is in
incorrect format, 0s offset will be used. For information about format of Offset, see "Offset Format
Specification" below.

The resulting date/time that will be put in themessage is formatted according to the xsd type of the
element. It can also be custom formatted. In that case, the cell with custom format has to contain
Offset followed by '#' character followed by Custom format specification (E.g. -1:25:00#hh:mm:ss).

For more information about the formatting according to xsd types and custom formatting, see
"Date/Time Formatting Used in Set Date Time Functions" on next page.

Offset Format Specification
TheOffset format contains a specification of the form:

[-][d.]hh:mm:ss[.ff]

Items in square brackets ([ and ]) are optional, colons and periods (: and .) are literal characters, and
other items are as follows:

l "-" optional minus sign indicating a negative time

l "d" optional days

l "hh" mandatory hours, ranging from 0 to 23

l "mm" mandatory minutes, ranging from 0 to 59
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l "ss" mandatory seconds, ranging from 0 to 59

l "ff" optional fractional seconds, consisting of 1 to 7 decimal digits

Examples:

l -54.12:00:59.1234567

l 0:00:00.001

l 365.0:00:00

Date/Time Formatting Used in Set Date Time Functions
Autodetection of types is based on the type of the element. The application can detect these xsd
date/time types:

l xsi:date - "yyyy-MM-dd" (e.g. 1984-11-28)

l xsi:time - "HH:mm:ss" (e.g. 23:59:59)

l xsi:dateTime - "yyyy-MM-ddThh:mm:ss" (For example, 2001-12-13T10:15:33)

No other formats, including JSON date/time formats, can be detected, as their internal type is
xsi:string. If the application cannot detect the format from the element's type, xsi:dateTime's format
is used by default. If you want to specify other output formats, use the custom format feature. For
details, see the custom formats below.

As noted above, the custom format is specified by adding '#' character after the offset (possibly
empty) followed by custom format specification, which consists of:

l "d" - The day of themonth, from 1 through 31.

l "dd" - The day of themonth, from 01 through 31.

l "f" .. "fffffff" - Fractions of a second, number of "f" characters specifies number of digits to print

l "h" - The hour, using a 12-hour clock from 1 to 12.

l "hh" - The hour, using a 12-hour clock from 01 to 12.

l "H" - The hour, using a 24-hour clock from 0 to 23.

l "HH" - The hour, using a 24-hour clock from 00 to 23.

l "m" - Theminute, from 0 through 59.

l "mm" - Theminute, from 00 through 59.

l "M" - Themonth, from 1 through 12.

l "MM" - Themonth, from 01 through 12.

l "s" - The second, from 0 through 59.

l "ss" - The second, from 00 through 59.

l "tt" - The AM/PM designator.

l "yyyy" - The year, four digit number.
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l regular characters (all characters except the ones mentioned above) - generated "as is". To
generate a character that has a special meaning (is part of one of the custom formats above,
such as “s”), place a '\' before it.

Custom Functions
To definemore complex conditions, Custom Functions can be used. These are to be used by a
advanced user aware of the complete system structure. Complex conditions can be set with
structured query language.

There are two classes of variables: Input ($input_*) and Data ($data_*). Input variables are those
present in a processing row during simulation. A more simplified explanation of Input variables is
that they are requests and Data variables are present in the datamodel.

Available variables:

l $input_string - original string - is automatically quoted in the place of usage

l $input_string_unquoted - original string - is not automatically quoted

l $input_int - original string converted to int data type - contains NULL if input string is not of
this data type

l $input_float - original string converted to float data type - contains NULL if input string is not
of this data type

l $input_date - original string converted to date data type - contains NULL if input string is not
of this data type

l $data_string

l $data_int

l $data_float

l $data_date

Examples of custom functions:

l Match request data (cast to integer) smaller than actual value (cast to integer) found in the
column $input_int < $data_int

l Match request data (cast to integer) smaller than actual value (cast to float) found in the column
$input_int < $data_float

l Match actual value found in the column (cast to string) equal to 'cat' string $data_string =

'cat'

l Match request data (cast to string) equal to 'cat' string $input_string = 'cat'

l Match request data (cast to string) equal to actual value (cast to string using an SQL 'LIKE'
operation) $input_string LIKE $data_string

l Match request data (cast to string) equal to any string starting with the actual value found in the
column $input_string LIKE $data_string + '%'

l Match request data (cast to string) containing a substring 'cat' $input_string LIKE
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'%cat%'

l Match request data (cast to date) smaller than actual data $input_date < $data_date

l Match request data smaller than actual data OR request data equal to 'dogs' string $input_
date < $data_dateOR $input_string = 'dogs'

Simulation Preview
Simulation Preview displays in real time how changes in the DataModel are affecting the
simulation. The Simulation Preview is in theView Optionsmenu in the DataModel Editor. The
Simulation Preview displays a simulation of themessage that has the request part equal to the
currently selectedmessage in the DataModel Editor. Themessage is passed to the simulation
engine and the result is displayed in the response section.

How to Add Service Call Activity
External services can be called by the Virtual Service. Only SOAP services are supported .

1. In the DataModel, select the operation forService Call Activity.

2. Click Import Activities under the Activity menu.

3. Enter the path of theWSDL schema.

4. Click Finish.

5. Click on Activity menu again.

6. Select operation of the imported schema.

7. Service Call Activity is added into each rule for the selected operation.

8. You can turn Off/On calling of the service for any rule.

9. UseCopy From function on any Service Call Activity request column or Virtual Service
response column.

a. Choose Copy from function

b. Move the cursor over the columns. The cursor type indicates if you can use a column as a
source for the Copy From function or not (using Copy From on incompatible data types in
not permitted).

c. Click on a source column.

d. The name of the source column is now displayed in brackets next to the Copy From
function.

10. You can set data in the rule rows for another columns or set other functions available in Data
Model Editor. For details, see "DataModel Editor" on page 38.

How to Add Data Sources
Additional data from external data sources can be added to a datamodel for testing purposes. The
supported format for this data is MS Excel (.xls, .xlsx).
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1. In the DataModel, click Data Driven Rule under theNew Rulemenu.

2. Enter the path and filename for the data source.

3. Optional: Use the first row of the table for column names.

4. Give the data source a name.

5. Click Finish.

How to Bind an External Data Source:

1. Select External Data rule.

2. Expand a table header and its child headers until you have a "leaf" header (only leaf headers
can be bound).

Click bind data... on the top of a column (if it is not visible, select Data Binding from the View
Options menu).

a. Optionally, an array can also be bound by selecting content that is not yet related to the
target sheet. TheEdit Sheet Relations dialog displays, and a Primary and Foreign Key
must be assigned. For more details on binding arrays, see "Array Binding" on next page.

b. When binding data formats and/or response types, you canmap values using the Data
Format Binding dialog box. For details, see "Data Format, Response Type, or Choice
Binding" on page 53.

Click OK to confirm and close the dialog box.

3. Click on any column in the displayed external data source table.

4. Repeat previous two steps for other columns.

5. Click OK.

How to Refresh an External Data Source:

1. Select theRefresh Data Source command from the Data Sourcemenu.

Alternately:

Right click on the rule number and select Refresh Data Source.

2. Click OK.

Note: Data source is refreshed when simulation is started/restarted.

How to change the path of a data source:

1. Select Change Data Source Path from the Data Sourcemenu.

Alternately:

Right click on the rule number and select Change Data Source Path.

2. Enter the path and filename for the data source.

3. Optional: Use the first row of the table for column names.

4. Click Finish.

Note: To remove a binding from the table, Click X next to theBind data button.
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Array Binding
This section discusses binding arrays. For details on adding data sources, see "How to Add Data
Sources" on page 50.

When themessage structure contains an array that needs to be data-driven, an Excel file needs to
be prepared for this. The file should contain database-like relationships, using primary and foreign
keys, which allow themapping of one row tomany.

The following example shows the relationship between a search definition and the search result. A
record in theSearchworksheet is identified via its primary key ‘id’, and referenced from the Search
Result worksheet via the foreign key ‘searchId’.

This enables the return of two rows for a search with id 3, or zero rows for search of id 4.

When an item under the array is going to be bound, theEdit Sheet Relations dialog box displays:
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This dialog box can be also launchedmanually from the context menu above rule or table headers.

The dialog box enables you to set relationships between worksheets, which is required for array
binding. There can bemultiple relationships from/to one worksheet.

Tip:When there is a 1 to 1 relationship, there will be exactly one item in the array for each row.
Items of the array can be located on the sameworksheet as other data, and the relationship will
be specified as the sameworksheet column for the Primary and Foreign Key.

Data Format, Response Type, or Choice Binding
This section discusses data format, response type, and choice binding. For details on adding data
sources, see "How to Add Data Sources" on page 50.

When binding to an Excel worksheet columnwhere the response can contain different Data
Formats (REST), different Response Types (SOAP), or amessage structure which can be
considered to contain different types, the following dialog box opens, enabling you to configure the
binding:

This dialog box enables you to configuremappings between real types/formats and cell values:

l The default value is used when no value from themapping table matches.

l The table enables you to configure each possible type/format to a cell value.

l If there is no need to bind different types/format in one Excel worksheet, a special column is not
required. In this case, a default binding is automatically created.

Performance Model
The PerformanceModel enables you to customize the performance of a service during simulation.
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When you create a Virtual Service, Service Virtualization creates a PerformanceModel associated
with it. For details, see "How to Create a Virtual Service" on page 16.

This model is then available to learn the performance of the real service and can be customized to
set specific performance rules either for the whole service, or its individual operations.

You can edit the PerformanceModel in the following ways:

l Boosters

Select to boost an aspect of the service performance (for example, CPU or Network
performance) and set amultiplier. Service Virtualization applies the boost to the relevant
performance criteria.

l Basic Performance Criteria

Set levels for the following performance criteria for specific operations of the service:

n Response Time [ms] - the time for the service to process a request and return a relevant
response.

n Threshold [hits/s] - themaximum number of requests and responses the service can process
without any impact on performance.

n Throughput Limit [MB/s] - themaximum data capacity the service can process.

l Advanced Performance Criteria

In addition to the basic criteria, set levels for the following criteria for specific operations of the
service:

n Tolerance [%] - the acceptable range of variation in performance for the operation.

n Maximum Hits per Second - themaximum number of requests and responses the operation is
allowed to process.

n Maximum Response Time - themaximum time for a response at peak performance levels.

For more details, see "How to Edit PerformanceModels" on page 56.

Each Virtual Service can havemultiple performancemodels. For details, see "How toManage
Models" on page 36.

Prior to recording or simulation you can select whichmodel to use, including non-customizable
models to ignore the performance or simulate the unavailability of a service. For details, see "How
to Select Models" on page 30.

Performance Model Editor
The PerformanceModel Editor enables you to configure performancemetrics for a Virtual Service
during simulation. The performance can be configured for the whole service or for its individual
operations.

Access the PerformanceModel Editor in one of the following ways:

l In the Virtualization Explorer, double-click the PerformanceModel you want to view or edit.

l In the Virtual Service Editor, in the PerformanceModel section, select themodel you want to
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view and click Edit.

The PerformanceModel Editor opens for the selectedmodel showing details at the service level.

Performance Model Editor - Service Level

The service view of the PerformanceModel displays the following content and controls:

Column Description

Model Name The name of themodel (click to edit).

Service /
Operation
Hierarchy

The hierarchy on the left shows the service name and a tree of its operations.
Click an item in the hierarchy to view its details.

Boosters A set of boosters to provide high-level control of the operations selected in the
operations table.

Booster
Controls

The sliding controls and inputs enable you to set the boost level for the selected
booster. The setting affects the various performance criteria displayed in the
operations table.

Operations
Table

Enables you to set more granular settings for individual performance criteria for
individual operations. Click Detail to open an operation level view of the
performancemodel.

Performance Model Editor - Service Level Content

Selecting an operation from the hierarchy or clicking its Detail link in the operations table opens the
detail for that operation.

Performance Model Editor - Operation Level
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The operation view of the PerformanceModel displays the following content and controls:

Column Description

Model Name The name of themodel (click to edit).

Service /
Operation
Hierarchy

The hierarchy on the left shows the service name and a tree of its operations.
Click an item in the hierarchy to view its details.

Operation
Name

Performance criteria for the operation (click to edit).

Performance
Graph

The graph displays the expected performance based on the criteria set for the
operation. Select Show Measured Data to view any recorded performance data
in the graph.

Performance
Criteria

Displays the advanced performance criteria for the operation with the option to
edit them.

Performance Model Editor - Operation Level Content

Formore details about the PerformanceModel Editor controls and their impact, see "How to Edit
PerformanceModels" below.

How to Edit Performance Models

Prerequisites:
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l Create a virtual service. For details, see "How to Create a Virtual Service" on page 16.

l Optional but recommended: Record the performance of the real service.

To Change the Performance of a Virtual Service:

1. In the Virtualization Explorer, double click onPerformance Model or once onEdit to open the
PerformanceModel

2. Click theBooster drop down list to display available options:

n CPU: Use the slider, enter a value or use the arrow buttons to assign a CPU power
multiplication factor .

n Network:Use the slider, enter a value or use the arrow buttons to assign a network
throughput multiplication factor.

n Cluster:Use the slider, enter a value or use the arrow buttons to assign a scalability
multiplication factor.

n Expert:Use the sliders, enter values or use the arrow buttons to assignmultiplication
factors toResponse Time, Hit Rate and Throughput Limit values.

n None: Turn off all boosters.

Note: Simulationmust be restarted to apply changes.

3. Clicking theBoost and Throughput Limit radio buttons applies the performance changes to
the service and all operations. These can also be selected individually by clicking the radio
button next to the required service or operation.

Advanced Performance Criteria

1. Click Detail or the name of the name of the operation in the side column to open theOperation
Detail page for that operation.

2. Modify values by clicking on the value and entering a new value or by dragging theMaximum
and Threshold indicators in the graph.

3. Optional: Click theShow Measured Data radio button to present Measured Data can be
presented in the graph.

4. Optional: Click the Throughput Limit radio button to change the value andmodify the
Throughput Limit .

5. Save themodifications with the File>Savemenu or closing themodel.

Service Description Editor
The Service Description Editor is used for editing a virtual service. It can be accessed by double
clicking a Service Description in the Virtualization Explorer, clicking Edit in the Service Description
section of the Virtual Service Editor, or selecting Edit URI Spaces from the URI Spaces menu of
the DataModel Editor.

The Service Description Editor consists of two parts: Service Editing and the URI Space Editing.
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Service Editing

Metadata are generally not part of a message body andmainly contain URL parameters and HTTP
headers.

Some types of metadata, such as HTTP Headers, are not required for tested applications; they
may be important for the protocol, but the application does not require them and they are not learned
for purposes of virtualization. By default they are disabled in the request but it is possible to enable
them and edit the data in the DataModel Editor for use in a simulation.

Metadata such as URI Parameters are generally used by tested applications and are enabled by
default.

"How to Edit Metadata" below

"Working with XML Schema" below

Note: Currently, REST is fully supported andWebSphereMQ is partially supported for editing.

URI Space Editing

"How to Add a URI Space" on next page

"How to Delete a URI Space" on next page

"Working with Data Formats" on next page

Note:Not all operations are available for all protocols.

How to Edit Metadata
Click Edit Request Metadata orEdit Response Metadata in the Service Description Editor to
open the Edit Request or ResponseMetadata window.

Select the item you would like to edit. Items can be filtered be entering text in the filter box.

l Click Add to Add New Metadata

1. Enter a name for themetadata

2. Select a type from the drop down box

3. Click OK.

l Select metadata and click Delete to remove themetadata from an item.

l Click Enable/Disable on either an item or its metadata to either activate or deactivate the
selection.

l Click Edit to change the settings of any metadata.

Working with XML Schema
Default XML Schema are presented in the Service Description Editor and can be edited, added or
removed from the service description.

l Click Add and select an existing schema (.xsd file) to have it added to available schema for the
service description.
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l Click Edit to open the schema and alter it in an xml editor.

l Click Delete to remove the schema from the service description.

How to Add a URI Space
In order to diversify your data, youmay want to createmore URI spaces to place the data in.

Existing URI spaces are presented in a tree structure on the left side of the Service Description
Editor. Clicking on the name of an existing URI space opens it in the URI Space Editor.

Click Add URI Space in the left bottom of the Service Description Editor.

Enter a URI path and click Add.

Note: Segments are separated with a '/' and the wildcard character '*' is used for several characters
or segments. An example being "Customer/*/Europe/*".

Caution: If a URI Space that is in conflict with an existing URI Space and the new URI Space is
more specific, the conflicting URI Space is split to several new URI Spaces and data from
all associated rules aremoved to these new URI Spaces.

How to Delete a URI Space
Select a URI Space in the left column of either the Service Description Editor or the URI Space
Editor and click Delete URI Space in the left column to remove the URI Space.

Working with Data Formats
Data formats can be added and removed from aURI Space as either Request or Response Data
Formats.

In either format, click Add to open AddMessage Type window and optionally:

1. Select Copy from existing URI Space.

2. Choose a URI Space from the drop down list.

3. Click Finish to add the format.

Or

1. Select New Data Format.

2. Choose a format from the drop down list.

3. Choose a type from the second drop down list.

Optionally, click External File to import schema other sources.

4. Click Finish to add the format.
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Composite Application Topology
The Topology Editor and Tools enables you tomodel composite applications by creating a visual
map of services, group them into larger composites, mark their types, and display the service calls
between them. This document refers to thesemaps as a Topology.

This chapter includes:

"How to Add Topologies" below

"How toModel Composite Applications" below

"How To Test Composite Applications" on page 62

"How to Create Virtual Services in Topologies" on page 65

"How to Reconfigure Clients in Topologies" on page 65.

"How to Learn Service Behavior in Topologies" on page 66.

"How to Simulate Service Behavior in Topologies" on page 67.

"Topology Editor Reference" on page 67

How to Add Topologies
To Add Topologies to the Virtualization Project:

1. In the Virtualization Explorer, open the project shortcut menu, and select Add > Topology or
from the File menu, select New > Topology to open the New File dialog box.

2. Select Topology, input a name, and click Add.

Service Virtualization creates a new topology as part of the virtualization project, and opens the
Topology Editor view and Tools. A default topology contains a service calling a limited access
service.

How to Model Composite Applications

Prerequisites:

l Add or import a topology to your project. For details, see "How to Add Topologies" above

To Edit Service Topologies:

1. Open the Topology Editor view.

In the Virtualization Explorer, double-click a topology to open the Topology Editor and Tools.
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2. Add items to the Topology.

Drag and drop the required items from Tools to the Editor.

Tools contains the following items:

n Service

A service with no particular notation.

n Limited Service

A servicemarked as having limited access.

n Secured Service

A servicemarked as requiring some authentication.

n Group

A generic box enabling you to organize services into larger composites for visual purposes.

3. Rename Services andGroups.

Open the context menu for a topology item and select Rename, select the item and press F2 or
double click the text.

4. Connect services together with Service Call Connectors.

Move the cursor to the right edge of the calling service until you see the hand icon, and then
click and drag the connector to the called service.

5. Mark relevant services as limited or secured.

Open the context menu for a service to use the following options:

n Set / Unset Limited Access

Mark or unmark a service as having limited access.

n Set / Unset Secured Access

Mark or unmark a service as requiring authentication.

Other Context Actions:

Context Action Icon Description

Test Begin testing of the service.

Preview Test Impact Switch On / Off the Test Impact highlighting.

Learn and Simulate Shortcut combo for Create Virtual Service and Learn.

Create Virtual Service Starts the Create Virtual Service wizard.

Rename (or double-
click the service)

Give a different name to the service.

Delete Remove the service from the topology.
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How To Test Composite Applications
In the topology view of a composite application, you can initiate a step-by-step process for testing a
particular service which guides you through all the processes required to virtualize, learn, and
simulate the limited access services that the tested service calls.

Prerequisites:

l Model your composite application by editing the topology, ensuring that youmark the limited and
secured services. For details, see "How toModel Composite Applications" on page 60.

To Test Services in a Composite Application:

l
In the Topology Editor, open the context menu for the services you want to test and select
Test.

The Tasks view opens showing a guided process for end-to-end setup and configuration for testing
the composite application. For details, see the following topics:

1. "How to Virtualize Services in the Tasks View" below

2. "How to Reconfigure Clients in the Tasks View" on next page

3. "How to Learn Services in the Tasks View" on next page

4. "How to Simulate Services in the Tasks View" on page 64

How to Virtualize Services in the Tasks View
If you have not yet created virtual services for limited access services or if there is somemissing
information, you are prompted to provide this information.

Prerequisites:

1. Model your composite application by editing the topology, ensuring that youmark the limited
and secured services. For details, see "How toModel Composite Applications" on page 60.

2. Mark at least one service as being tested. For details, see "How To Test Composite
Applications" above.

To Virtualize Services in the Tasks View:

1. To virtualize services, do one of the following:

n To provide all themissing information for all virtualized services, click Virtualize Services.

n To provide themissing information for selected virtualized services, expandCustomize
Virtualization of Services, select the Services to virtualize, and click Virtualize Selected
Services.

The Virtualize Services dialog box opens.
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2. Optional: The Virtualize Services dialog box displays the services requiring additional
information. Click Next to continue.

Tip:Select Do not show this message again if you want to skip this information panel in
future testing.

3. Specify Virtualization for Service:

Youmay either select an existing virtual service from the drop down list or create a new virtual
service. See "How to Create a Virtual Service" on page 16.

When all themissing information for each service is complete, Virtualize Services is marked as
complete and you proceed to Reconfigure Clients. For details, see "How to Reconfigure Clients in
the Tasks View" below.

Service Virtualization adds the virtual services, any new service descriptions, and a data and
performancemodel for each service to the Virtualization Explorer. The Runtime View also updates
to include the new virtual services.

How to Reconfigure Clients in the Tasks View
In cases where Service Virtualization can only perform intrusive virtualization, youmust reconfigure
calling services to use the virtual services instead of the real ones.

Prerequisites:

1. Model your composite application by editing the topology, ensuring that youmark the limited
and secured services. For details, see "How toModel Composite Applications" on page 60.

2. Mark at least one service as being tested. For details, see "How To Test Composite
Applications" on previous page.

3. Provide any missing information required to virtualize limited and secured services. For details,
see "How to Virtualize Services in the Tasks View" on previous page.

To Reconfigure Clients:

1. Click View to open the Instructions to Reconfigure Clients dialog box showing the particular
details for the virtualized services in your composite application.

2. Optional: Click Save As to save a text document copy of these instructions.

3. Click Mark as Completedwhen you have reconfigured the tested service and are ready to
proceed to Learn Services. For details, see "How to Learn Services in the Tasks View" below.

How to Learn Services in the Tasks View
When your virtual services are properly setup and the calling services reconfigured to use them,
you can learn the behavior of the composite application.

Note: If you already have simulationmodels for your composite application, you can click Skip to
Simulate Services to proceed without recording any additional service communication. For
details, see "How to Simulate Services in the Tasks View" on next page.

Prerequisites:
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1. Model your composite application by editing the topology, ensuring that youmark the limited
and secured services. For details, see "How toModel Composite Applications" on page 60.

2. Mark at least one service as being tested. For details, see "How To Test Composite
Applications" on page 62.

3. Provide any missing information required to virtualize limited and secured services. For details,
see "How to Virtualize Services in the Tasks View" on page 62.

4. Reconfigure any components that call the virtualized services. For details, see "How to
Reconfigure Clients in the Tasks View" on previous page.

To Learn Services:

1. Click Learn Services to put the virtual services into LearningMode.

2. Run your test through the composite application using a client or test script. Service
Virtualization records the requests and responses for each virtualized service and creates a
simulationmodel for each.

As you run your test, the Runtime View updates the details for each virtual service.

When you have finished recording, you are ready to proceed to Simulate Services. For details, see
"How to Simulate Services in the Tasks View" below.

How to Simulate Services in the Tasks View
When you have a simulationmodel, you can simulate the behavior of the real services without
using them. The tested service calls the virtual services and returns results based on the simulation
model instead of actual responses from the real services.

Prerequisites:

1. Model your composite application by editing the topology, ensuring that youmark the limited
and secured services. For details, see "How toModel Composite Applications" on page 60.

2. Mark at least one service as being tested. For details, see "How To Test Composite
Applications" on page 62.

3. Provide any missing information required to virtualize limited and secured services. For details,
see "How to Virtualize Services in the Tasks View" on page 62.

4. Reconfigure any components that call the virtualized services. For details, see "How to
Reconfigure Clients in the Tasks View" on previous page.

5. Learn the behavior of the virtualized services. For details, see "How to Learn Services in the
Tasks View" on previous page.

To Simulate Services:

1. Click Simulate Services to put the virtual services into simulate mode.

2. Run your test through the composite application using a client or test script. Service
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Virtualization processes the requests to each virtualized service and returns responses based
on the simulationmodel for each.

As you run your test, the Runtime View updates the details for each virtual service.

How to Create Virtual Services in Topologies

Prerequisites:

l Your topology must contain at least one service. For details, see "How toModel Composite
Applications" on page 60.

To Create Virtual Services:

1. In the Topology Editor, open the context menu for the service you want to virtualize, and select
Create Virtual Service.

2. The Virtualize Services wizard steps through the following dialogs for the service, depending
on which information is required:

Specify Virtualization for Service

a. Youmay either select an existing virtual service from the drop down list or create a new
virtual service. See "How to Create a Virtual Service" on page 16.

b. Add Service Security Settings

If a service is marked as secure and does not already have any associated authentication,
Service Virtualization cannot access the service and prompts you to provide
authentication. For details, see "How to Set Authentication Credentials" on page 25.

When the service contains all the required information the topology diagram updates to indicate that
the service is virtualized.

When you virtualize services, the components that call themmay require reconfiguration. For
details, see "How to Reconfigure Clients in Topologies" below.

How to Reconfigure Clients in Topologies
When you virtualize a service in the topology editor, the editor indicates that the calling components
may require reconfiguration by adding an exclamation icon to the calling component.

Prerequisites:
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l Your topology must contain at least two services. For details, see "How toModel Composite
Applications" on page 60.

l A called servicemust have been virtualized. For details, see "How to Create Virtual Services in
Topologies" on previous page.

To Reconfigure Clients:

1. In the Topology Editor, click the exclamation icon to open the Reconfigure Service pop-up.

The pop-up displays the endpoint details for the real and virtual services the component calls,
providing the information you require to reconfigure the calling component.

2. When you have reconfigured the calling component, click Mark Completed and close the pop-
up.

The exclamation icon is removed from the calling component.

How to Learn Service Behavior in
Topologies

In the topology view of a composite application you can learn the behavior of individual services.

Prerequisites:

l Edit the topology, marking limited and secured services, and importing service descriptions for
the services you want to learn. For details, see "How toModel Composite Applications" on page
60.

To Learn Service Behavior:

1. In the Topology Editor, open the context menu for each service you want to record and select
Learn. The topology diagram changes, displaying the service in LearningMode.

2. Run your test through the composite application using a client or test script. Service
Virtualization records the requests and responses for the virtualized services and creates
simulationmodels for each one.

As you run your test, the Runtime View displays details for each virtual service.

3. When you have finished recording, open the context menu for the services you are recording
and select Stop Learning. The topology diagram changes, displaying the service in Simulate
Mode. Optionally, select Simulate and the application stops the learning process and switches
directly to simulating.
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How to Simulate Service Behavior in
Topologies

In the topology view of a composite application you can simulate the behavior of individual
services.

Prerequisites:

1. Edit the topology, marking limited and secured services, and importing service descriptions for
the services you want to simulate. For details, see "How toModel Composite Applications" on
page 60.

2. Learn the behavior of the services you want to simulate. For details, see "How to Learn Service
Behavior in Topologies" on previous page.

To Simulate Service Behavior:

1. In the Topology Editor, open the context menu for each service you want to record and select
Simulate. The topology diagram changes, displaying the service in SimulateMode.

2. Run your test through the composite application using a client or test script. Service
Virtualization processes the requests to each virtualized service and returns responses based
on the simulationmodel for each.

As you run your test, the Runtime View displays details for each virtual service.

Topology Editor Reference
The annotation for each service varies depending on its settings and various stages of
configuration.

Service Diagram Description

An empty service which does not contain an associated service
description.

A servicemarked as having limited access.

A servicemarked as secure, requiring credentials to access.

A virtualized service.
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Service Diagram Description

A virtualized service in LearningMode. Service Virtualization records
any requests and responses through this service and adds them to the
associated SimulationModel.

A virtualized service in SimulationMode. Service Virtualization
monitors any requests to this service and returns responses based on
the associated SimulationModel.

A servicemarked as being tested.

A service suggested for virtualization.

A service requiring attention because it calls a virtualized service and
may require reconfiguration to call the virtual service instead of the real
one.
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An agent represents a component between a client and a real service. It maintains endpoints where
client communication is received.

See "How to Change Agent Configuration" on next page.

There are a few agent types in Service Virtualization:

HTTP(S) Gateway Agent

Serves to virtualize HTTP communication. A virtual HTTP endpoint is created tomediate between
a client and a real service HTTP endpoint. During the learning process, real communication is
forwarded to a real service HTTP endpoint and the communication is recorded. See "Configuring
HTTP(S) Gateway Agent" on next page.

HTTP(S) Proxy Agent

Serves to virtualize HTTP and HTTPS communication. No endpoint is created, and an HTTP(S)
proxy is used to receive and forward client communication to a real service HTTP or HTTPS
endpoint. See "Configuring HTTP(S) Proxy Agent" on page 72

TIBCO EMS Non Intrusive Agent

Serves to virtualize JMS communication in TIBCOEnterpriseMessage Service™ (TIBCOEMS).
No endpoint is created and a client application does not require reconfiguration. The agent listens to
system topics where all communication can bemonitored. When the service is switched to
Simulatingmode, it manipulates the service JMS account permissions in the JMS bus (EMS) to
forbid a real service from receiving client communication. Administrator account credentials in
TIBCOEMS are required. See "Configuring TIBCOEMS Non Intrusive Agent" on page 74

Generic JMS Agent

Serves to virtualize JMS communication in any JMS provider (IBM®WebSphere® MQ, Weblogic,
JBoss, ...). It uses general JMS API and JNDI to lookup and work with JMS resources (context
factories, connection factories, queues, topics). It loads Java JVM (Java Virtual Machine) with
JMS provider libraries required for JMS communication in process. See "Configuring Generic JMS
Agent" on page 75

Note: Generic JMS Agent only supports JMS BytesMessage and TextMessage according to the
SOAP over JMS specifications.

IBM® WebSphere® MQ

See "ConfiguringWebSphereMQAgent" on page 77.

Forwarding HTTP(S) Gateway/Proxy Agent Communication through HTTP Proxy

See "Forwarding HTTP(S) Gateway/Proxy Agent Communication through HTTP Proxy" on page 79

Configuration of Windows Firewall and HTTP Settings
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"Configuration of Windows Firewall and HTTP Settings" on page 80

How to Change Agent Configuration
Agent configuration in Designer UI

If using the embedded server, the agent configuration can be changed in the Designer UI from the
menu: Tools > Options > Agents.

Agent configuration in configuration files.

Agent configurations for both Embedded and Standalone servers are stored separately in the file
system.

l Embedded server agent configuration at:

n %APPDATA%\Hewlett-

Packard\VirtualServiceDesigner\Agents\AgentConfigurations.xml

l Standalone server agent configuration at:

n %[INSTA-

LLLOCATION]%\StandaloneServer\bin\Agents\AgentConfigurations.xml

To change the agent configuration, youmust change the agent configuration file manually. To apply
the changes in the configuration files, restart the changed server.

Configuring HTTP(S) Gateway Agent

To configure the HTTP(S) Gateway Agent:

From the Toolsmenu, select Options, click theAgents tab and chooseHTTP Gateway from the
treemenu.

There are two configuration options:

l Port: The port of the Service Virtualization Server used by the agent to deploy virtual services.

l Forward UnknownRequest To: The URL prefix that forwards requests other than the requests
to virtual services.
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In the case you are not able to reconfigure clients on a service basis (ie: changing the endpoint of
each service to a virtual service) and all of your HTTP(S) services reside on a single host, you can
use the Forward Unknown Request To option of the HTTP(S) Gateway agent.

Example:

The client is calling several backend services:

http://esb.demo.hp.com:8080/BackendServices/MemberAccounts

http://esb.demo.hp.com:8080/BackendServices/ExchangeRate

http://esb.demo.hp.com:8080/BackendServices/Approval

You are only virtualizing theMemberAccounts service but are only able to reconfigure the
application to use another host for all services rather than changing the endpoint of just the one
MemberAccounts service in the application.

You reconfigure your application to use the SV Server HTTP Gateway at:

http://svserver.hp.com:7200 instead of http://esb.demo.hp.com:8080

The application will access backend services at these endpoints:

http://svserver.hp.com:7200/BackendServices/MemberAccounts

http://svserver.hp.com:7200/BackendServices/ExchangeRate

http://svserver.hp.com:7200/BackendServices/Approval

You create theMemberAccounts service so this functions but the other services would be
inaccessible for the application until you virtualized all of them.
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To avoid the virtualization of all backend services set the DEFAULT TARGET HOST to

http://esb.demo.hp.com:8080

Now all requests to non-virtualized services are forwarded to the
http://esb.demo.hp.com:8080 host and reaching the real services you do not intend to
virtualize now.

Note: The Forward UnknownRequest To can contain base URL in several formats: the host,
optional port and optional base path, i.e.: http://esb.demo.hp.com,
http://esb.demo.hp.com:8080

Additional HTTPS Gateway Agent configuration.

The HTTPS Gateway agent requires the same steps as the HTTP Gateway agent.

HTTPS requires assigning a certificate to a port used for listening.

Generate a certificate with a private key (if you don’t have one), import the certificate to either a
current user’s personal store (for an embedded server) or to a local machine’s personal store (for
a standalone server). Grant access to the private key to the current user (for an embedded
server) or to the account running the standalone server.

To configure HTTP ports and to install a self-signed SSL certificate we provide the tool
configureHttpAgent.bat.

See How to Install Self-Signed Certificate in the installation guide.

To install a custom certificate we provide the tool addCustomCertificate.bat.

See How to Install Custom Certificate in the installation guide.

To set agent configuration properties, see "Configuring HTTP(S) Proxy Agent" below.

Configuring HTTP(S) Proxy Agent
The HTTP(S) proxy agent dynamically generates certificates for requested hosts on the fly. The
certificates are signed by the configured certificate authority (CA). The CA certificate and private
key can be configured in the HTTP(S) Proxy agent configuration.

The client must trust certificates signed using a configured CA otherwise the communicationmay
fail due to the agent rejecting it.

HTTP(S) Agent Configuration provides options as per the following image:

HP Service Virtualization (2.10)Page 72 of 105



User Guide
Chapter 6: Supported Technologies And Environments

1. HTTP Proxy Settings Port – port for HTTP communication

2. HTTPS Proxy Settings Port - port for HTTPS communication

Certification authority

3. CA Certificate File - file used to generate host certificates

4. Private key – private key for above configured file

5. Password – password for private key

Note: In case of Java based clients running on JDK 6 or newer and in the case of self-signed
certificates, it may be necessary to add the “-
Dsun.security.ssl.allowUnsafeRenegotiation=true” startup parameter or the
client may reject communication with the HTTPS Agent. See
http://java.sun.com/javase/javaseforbusiness/docs/TLSReadme.html for more details.
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Configuring TIBCO EMS Non Intrusive Agent

The TIBCOEMS Non Intrusive agent is not installed by default and if required, must be installed
manually. The TIBCOEMS Non Intrusive agent requires 2 DLL libraries that are not supplied with
the product: Tibco.EMS.dll and Tibco.EMS.Admin.dll. These libraries are supplied with
the installation of TIBCOEnterpriseMessage Service™ (EMS) and can be found in the bin
directory in the EMS installation folder. The typical default location is c:\tibco\ems\6.0\bin\.

1. To install the TIBCOEMS agent, ensure that the TIBCOEMS libraries Tibco.EMS.dll and
Tibco.EMS.Admin.dll are either registered in the Global Assembly Cache (GAC) or copied
to the Designer\bin and StandaloneServer\bin directories in the application
installation directory. Installation to GAC should be an optional part of the TIBCOEMS
installation.

The applicationmust be restarted after libraries have been copied to the directory.

When the agent is installed properly, configuration needs to be setup according to EMS
specifics.

2. Setting agent configuration properties:
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a. Provider Url – Host and Server Port where EMS is running.

b. Credentials – Username and Password for EMS account with appropriate privileges to
change permissions on destinations and the JMS server (admin account).

Configuring Generic JMS Agent

A standard JMS API with JNDI lookups is being used in Generic JMS Agent. Environment with
JMS resources must be configured first:

1. Create virtual destination(s) in JMS server (WebpshereMQ, Weblogic, JBoss, …)

a. Create Virtual Request destination

b. Create Virtual Reply destination, only if you want to use permanent ReplyTo destination,
otherwise temporary ReplyTo destination will be used

2. Configure JNDI mapping for virtual destination(s) to allow agents lookup destination(s) in
JNDI.

a. For Virtual Request destination

b. For Virtual Reply destination only if permanent ReplyTo destination is used

3. When the JMS environment and resources are configured, the agent configuration needs to be
setup according to JMS provider specifics.

Setting Generic JMS Agent configuration properties:
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JNDI URL –URLwhere JNDI provider and JNDI context with JMS resources is located

Context Factory – provider specific context factory

Class Path – class path with all necessary JMS provider specific libraries for JMS
implementation

Username

Password

Note: To ensuremaximum compatibility use the same JMS/J2EE jar libraries for the agent
classpath that are in use by the client application. If not possible, please follow your
application server documentation for selection of correct J2EE/JMS libraries.

Example of Generic JMS Agent configuration:

Agent configuration for WebLogic 10.3:

l JNDI URL: t3://czvm58.devlab.ad:7001/

l Context Factory: weblogic.jndi.WLInitialContextFactory

l Class Path:

C:\Temp\WL103\wlthint3client.jar

nNote: The above sample usedWebLogic Thin T3 Client. In case of issues, please use other
Weblogic Client libraries (e.g. “WebLogic Full Client” using “wlfullclient.jar”). See
chapter 2 of “Overview of Stand-alone Clients” in your “Oracle® FusionMiddleware
Programming Stand-alone Clients for OracleWebLogic Server 11g Release 1”
documentation for more details.

Agent configuration for MQ-7.0.1.3 on WAS-6.1.0:

l JNDI URL: corbaloc::czvm24.devlab.ad:2809/NameServiceServerRoot

l Context Factory: com.ibm.websphere.naming.WsnInitialContextFactory

l Class Path:

C:\Temp\WAS6\com.ibm.mq.jar;

C:\Temp\WAS6\com.ibm.mq.jmqi.jar;

C:\Temp\WAS6\com.ibm.mqjms.jar;

C:\Temp\WAS6\com.ibm.ws.admin.client_6.1.0.jar;

C:\Temp\WAS6\com.ibm.ws.runtime_6.1.0.jar;

C:\Temp\WAS6\connector.jar;

C:\Temp\WAS6\dhbcore.jar;

C:\Temp\WAS6\fscontext.jar;

C:\Temp\WAS6\ibmorb.jar;

C:\Temp\WAS6\jms.jar;

C:\Temp\WAS6\jndi.jar;

HP Service Virtualization (2.10)Page 76 of 105



User Guide
Chapter 6: Supported Technologies And Environments

C:\Temp\WAS6\ldap.jar;

C:\Temp\WAS6\providerutil.jar

Agent configuration for JBoss 6.0:

l JNDI URL: jnp://[machine-name]:1099/

l Context Factory: org.jnp.interfaces.NamingContextFactory

l Class Path:

C:\Temp\JBAS6\concurrent.jar;

C:\Temp\JBAS6\hornetq-core-client.jar;

C:\Temp\JBAS6\hornetq-jms-client.jar;

C:\Temp\JBAS6\jboss-client.jar;

C:\Temp\JBAS6\jboss-ejb3-core-client.jar;

C:\Temp\JBAS6\jboss-ejb3-ext-api.jar;

C:\Temp\JBAS6\jboss-jms-api_1.1_spec.jar;

C:\Temp\JBAS6\jboss-logging.jar;

C:\Temp\JBAS6\jnp-client.jar;

C:\Temp\JBAS6\netty.jar

Configuring WebSphere MQ Agent
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Prerequisites for using WebSphere MQ Agent:

TheWebSphereMQAgent is not installed by default. The agent is dependent on the IBM
WebSphereMQClient 7.0.1.6 or newer (amqmdnet.dll library with version 1.0.0.3 and its
dependencies). The IBMWebSphereMQClient full installation places the required library in the
Global Assembly Cache (GAC)making the agent available (if the client is installed while the server
or the designer is running, youmust restart the application prior to enabling the agent).

Because theWebSphereMQAgent uses the IBMWebSphereMQClient internally, you can use all
diagnostic tools and logs provided by the client if you need to investigate any issues with
WebSphereMQ communication between HP Service Virtualization and the IBMWebSphereMQ
Server.

To configure WebSphere MQ agent:

From the Tools menu, select Options and the Agents tab.

The following options are available:

l IsEnabled – turn on or off the agent. The agent can be turned on only if prerequisites were
fulfilled.

l Queue Manager Name – the name of the queuemanager the agent will be connecting to.

l Channel Name – the name of the TCP channel the agent will use to connect to the queue
manager.

l Host – the name of the server hosting the queuemanager.

l Port – the TCP port where the channel listens for client connections.

l CCSID – the character set used by the host.

l User name – the user connecting to the queuemanager.

l Password – the password for the user connecting to the queuemanager.

Additional global configuration

There are additional configurations available through the application configuration files:

%[INSTA-

LLLOCATION]%\StandaloneServer\bin\HP.SV.StandaloneServer.exe.config

%[INSTALLLOCATION]%\Designer\bin\VirtualServiceDesigner.exe.config

The following configuration elements can be defined in the appSettings section in those
configuration files:

<add key="MQAgent.DefaultCharacterSet" value="0"/>

<add key="MQAgent.UseUtfMethods" value="false"/>

<add key="MQAgent.StripXmlDeclaration" value="true"/>

These configuration elements setup global behavior for processingWebSphereMQmessages:

l MQAgent.DefaultCharacterSet – configures default character set for simulated XML
responses. This configuration is used if the character set is not recorded as messagemetadata.
If the value is set to 0 the character set is not set.
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l MQAgent.UseUtfMethods – HP Service Virtualization supports binary and XMLmessages
overWebSphereMQ. When using an XML service, themessage can be either transferred as a
string (with a specified character set) or as binary data (UTF). By default the agent reads and
writes messages as a string. If binary messages with UTF content should be used instead, set
the value to true.

l MQAgent.StripXmlDeclaration – when the value is configured to true, XMLmessages sent
from the agent will not contain XML declarations.

Agent limitations

l TheWebSphereMQAgent instance can only use queues from a single Queuemanager.

l TheWebSphereMQAgent instance can only use a single TCP channel to connect to the Queue
manager.

l CCSID configuration in theWebSphereMQAgent instance requires an application restart.

l CCSID configuration is global for whole the application (there cannot be two agents with
different CCSIDs).

l TheWebSphereMQAgent is not able to automatically reconnect when a TCP connection to the
WebSphereMQServer is lost. Each service using the agent must be restarted (alternately,
restart the whole application).

Forwarding HTTP(S) Gateway/Proxy Agent
Communication through HTTP Proxy

It is possible to forward the HTTP(S) communication between HTTP(S) Proxy or Gateway agents
and real service through additional proxy (proxy chaining).

To enable proxy chaining, perform following steps:

1. From the Tools menu, select options and the Agents tab.

2. From either the HTTP Gateway, HTTP(S) Proxy or HTTPS Gateway settings, select theUse
another proxy server to communicate with real services options and click theSettings
link.

The following options are available:

l Proxy host and Port – Address or hostname of proxy machine and port number.

Note:With the HTTP Proxy agent, both HTTP and HTTPS communication is forwarded through
same port.

l Credentials – Credentials for authentication. Authentication is automatically detected and
supports BASIC, DIGEST, NTLM, and Negotiate authentication types.

n None – No username / password used for proxy authentication.

n Current User – Current username and password provided by windows integrated
authentication is used. Note: Only NTLM andNegotiate authentication is supported.

n Custom Credentials – Custom username and password.

l Do not use proxy server for addresses beginning with
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n Defines list of addresses (separated with semicolon or new lines) for which proxy won’t be
used.

l Bypass proxy server for local addresses.

n If checked, proxy is not used when accessing local addresses (IPv4 and IPv6 loopback and
current machine hostname).

Configuration of Windows Firewall and HTTP
 Settings

TheWindows Firewall and HTTP settings may require configuration if a user changes the HTTP(S)
agent port, with the exception of HTTPS Proxy Agent.

The user may need to configure:

l HTTP settings (if UAC is enabled):

n Allow the new agent port using the provided configuration tool or manually from the command
line.

l Windows Firewall (if Windows Firewall is enabled)

n AddWindows Firewall inbound rule for the new agent port using the provided configuration
tool or manually from the command line.

HTTP andWindows Firewall settings for the default HTTP(S) agent ports are configured during the
initial installation.

Caution: The port selected for the HTTP(S) agent must not be used by any other application and it
must not be blocked by a firewall.

If UAC is enabled or the user is not in a local administrator role, the user must obtain permission to
listen on the port. To assign such permission, use the command line interface with elevated
privileges (such as administrator) and:

1. Use the provided tool configureHttpAgent.bat. See HTTP Port Configuration in the
installation guide for command line options.

2. Ormanually run the following command (the following example is for HTTP port 9000 granting
permission to all users on the current machine):

a. Windows Server 2008 andWindows 7:

netsh http add urlacl url=http://+:9000/ user=EVERYONE

listen=yes delegate=no

b. Windows XP andWindows Server 2003 (See Prerequisites in the installation guide for
httpcfg tool installation):

httpcfg set urlacl -u http://+:9000/ -a "D:(A;;GX;;;WD)"

It is only required to run this command once for each port. The registration remains in the
system until it is removed.
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If Windows Firewall is enabled the firewall inbound rules must be added to allow HTTP
communication from remote host with HP Service Virtualization. To add these exceptions, use the
command line interface with elevated privileges (such as administrator) and do one of the following:

l Use the provided tool configureHttpAgent.bat to addWindows Firewall exceptions. See
HTTP Port Configuration in the installation guide for details.

l Or add themmanually (the following example is adding firewall exceptions for HTTP port 9000
for all applications):

To add HTTP Proxy port exception for port e.g. 9000, run the following commands:

netsh firewall add portopening TCP 9000 "Port 9000 HTTP Proxy" ENABLE

netsh firewall add portopening UDP 9000 "Port 9000 HTTP Proxy" ENABLE
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Service Virtualization Server
HP Service Virtualization Server is a version of the runtime that is completely separate from the
Service Virtualization Designer. It provides the same functionality as the Embedded Server running
in the Designer, such as creating and learning services and simulating the use of learned rules or
rules provided by the user, without the need to run the Designer.

Note: A valid product license is required to start the application. For details, see the License
Installation section of theHP Service Virtualization Installation Guide.

The Service Virtualization Server can be configured as either secured or unsecured. To prevent
unauthorized access, it may be configured as secured. For additional details and configuration
information on the Service Virtualization Server, see the HP Service Virtualization Server section of
theHP Service Virtualization Installation Guide.

This chapter includes:

Accessing a Secured Service Virtualization Server 83
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Accessing a Secured Service Virtualization
Server

You can determine whether the Service Virtualization Server is secured based on its URL. The
URL of an unsecured server begins with http, whereas the URL of the secured server begins with
https. For example, the URL of a secured server might be
https://mymachine.com:6085/management. In addition, the port of the secured server is different
from that of the unsecured server.

When the HP Service Virtualization Designer contacts a secured Service Virtualization Server for
the first time, it requests user input in order to establish a secured communication channel.

To access a secured Service Virtualization Server:

1. When the HP Service Virtualization Designer contacts a secured Service Virtualization server
for the first time, the following dialog box opens:

Select Trust the certificate permanently to prevent the Designer from prompting you again.

2. Click Yes to accept the certificate. The following dialog box opens:

Enter credentials to connect to the Service Virtualization Server. For details on credentials
validation and user authentication, see theHP Service Virtualization Installation Guide.
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Security
"How to Set Authentication Credentials " on next page

Service virtualization supports virtualization of secured services using either HTTP transport level
security or subset of SOAP message level security.

Security

Security consists of four components:

l Confidentiality – data are encrypted. Only an ultimate recipient can read data.

l Integrity – data are signed. A recipient can validate that data have not beenmodified during
transmissions.

l Authentication – identity of a client is transferred with message.

l Authorization – service validates that an authenticated client can execute required operation.

Service virtualization doesn’t deal with authorization. Authorization logic is left for the real service
but service virtualizationmust deal with other parts:

l Confidentiality – service virtualizationmust be able to decrypt themessage passed to virtual
service to learn them and it must be able to encrypt messages passed to the real service

l Integrity – service virtualizationmust be able to validate signatures passed in requests from
clients and responses a real service and it must also be able to sign requests passed to a real
service and responses passed to clients.

l Authentication – service virtualization doesn’t validate incoming clients but in some scenarios it
must have access to their credentials (certificates with private keys or user names with
passwords) to pass them to a real service.

Transport security

Transport level security is point-to-point. Security is ensured only on the transport level connection
between twomachines. Transport level integrity and confidentiality is ensured through SSL / TLS
(HTTP(s) Proxy agent or the HTTPS Gateway agent) and transport level authentication is ensured
with HTTP authenticationmechanisms.

Transport authentication in service virtualization is used only in pass through and recordingmodes
to access the real service. It is transparently managed by the HTTP Gateway or HTTP(S) proxy
agents. Transport authentication only requires that correctly configured credentials are available in
the Credential Store

See "How to Set Transport Security" on page 91

Message security

Message level security is end-to-end. Security is ensured on themessage level – security is part of
message data which can be passed throughmany intermediaries (many connections) without
revealing unsecuredmessage content.
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Message security in service virtualization is used for pass through, recording and simulation
modes.

See "How to Set Message Security" on next page

Mixed security

Mixed security uses transport security to ensure confidentiality and integrity andmessage security
to pass client credentials (authentication). This security configuration requires the usage of the
HTTPS agent andmessage security modes with names ending with OverTransport.

How to Set Authentication Credentials
Some services may require client authentication either on either the transport or message level.
When virtualizing these services, the application needs to know what client credentials are used to
connect to the real service. The only exception is a scenario in which a real service with HTTP
transport authentication (Basic, Digest, NTLM) is virtualized through an HTTP(S) proxy agent. In
this case, authentication requests are forwarded and the service virtualization doesn’t need the
credentials in the service’s credential store.

Prerequisites:

l User of the virtual servicemust exist in the local user store of aWindows installation.

To Set Service Security Settings:

1. Access Security Settings:

In the Virtualization Explorer view, open the Editor view for a virtual service and expand the
Security Settings section.

In the Topology Editor view, virtualize a secured service that does not have any authentication
set. For details, see "How to Create Virtual Services in Topologies" on page 65.

In the Topology Tasks view, virtualize secured services that do not have any authentication
set. For details, see "How to Virtualize Services in the Tasks View" on page 62.

2. Tomodify the authentication credentials for a secured service, click Edit Credential Store
and do any of the following:

a. To add user credentials:

i. Click Add Identity to open theEdit Identity Details dialog box.

ii. Input a Username and Password.

iii. Optional: Select Show Password to display the password in Security Settings.

iv. Optional: Add Certificate

v. Click OK to add the credentials to the Security Settings dialog box.

b. To edit user credentials:
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i. Select the user to edit, and click Edit Identity to open theEdit Identity dialog box.

ii. Input a Username and Password.

iii. Optional: Select Show Password to display the password in Security Settings.

iv. Click OK to change the credentials in theSecurity Settings dialog box.

c. To remove user credentials:

i. Select the user to remove, click Remove Identity, and confirm your decision.

ii. To import credentials:

iii. Click Import to open the Import Identities dialog

iv. Select the virtual service which contains identity you want to import

v. Select the identity you want to import

vi. Click OK to import the identity from selected virtual service

d. Save the Virtual Service.

How to Set Message Security
If the service is secured with message security, use the following security settings:

Basic Message Security Basic Settings

l Mode – Predefined supportedmessage security mode

l Real Service Identity – The identity of the real service (certificate) is stored in the Credential
Store. This setting is used if a service uses a certificate for message security. The public key of
the certificate is used to encrypt messages sent to the real service.

l Virtual Service Identity – The identity of the virtual service (certificate) is stored in the Credential
Store. The purpose of this configuration is the same as in Real Service Identity. If the Real
Service Identity contains the certificate with a private key this setting doesn’t need to be
configured. In this scenario, the Real Service Identity is also used as the identity of the virtual
service. If the Real Service Identity contains only a certificate without a private key, this setting
must be configured to provide the identity of the virtual service. The configured identity must
contain a certificate with a private key as the service requires the private key to decrypt the
messages coming from the client. Clients must trust the certificate used as the identity of the
virtual service.

Advanced Message Security Settings

l Protection Level – Describes the level of security applied to eachmessage. This configuration
has service scope levels . All messages must have the same security requirements.

l Message Protection Order – Describes the order of protection operations used to secure
messages

l Message Security Version – Describes a set of WS-* specifications used to establish security

l Require Derived Keys – Defines if supporting tokens must use derived keys

l Include Timestamp –Defines if messages must contain security timestamp
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l Allow Serialized Token on Reply – Defines if replies can contain a service token used to sign the
message. This setting is only used for asymmetric security bindings.

Configuring CertificateOverTransport
Certificate over transport mode uses an endorsing supporting binary token over HTTPS:

l Transport security binding

n Algorithm suite: Basic256

n Layout: Strict

l Endorsing supporting token

n X509Token (WssX509V3Token10) included always to recipient.

n Inclusion type: MustSupportRefThumbprint / RequireThumbprintReference

Prerequisites:

• Create a Virtual Service. See "How to Create a Virtual Service" on page 16

• Credential Storemust contain an identity with each used client certificate.

• Certificates must contain a private key.

To configure CertificateOverTransport:

1. Check Enabled inMessage Security.

2. Select CertificateOverTransport inMode.

l Do not configureReal Service Identity orVirtual Service Identity.

Advanced settings for CertificateOverTransport:

l Protection Level – this setting has no effect because encryption and signing is provided by the
transport level (HTTPS)

l Message Protection Order – this setting has no effect because encryption and signing is
provided by the transport level (HTTPS).

l Message Security Version –only WS-Security 1.1 is supported because this configurationmode
requires thumbprint token inclusionmode which is not supported inWS-Security 1.0.

l Require Derived Keys – this setting should not be changed.

l Include Timestamp – this settingmust be checked because the endorsing supporting token
passed in the request must sign the timestamp header.

l Allow Serialized Signing Token on Reply – this setting has no effect.

Configuring UserNameOverTransport
User name over transport mode uses a signed supporting user name token over HTTPS:
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l Transport security binding

n Algorithm suite: Basic256

n Layout depends onWS-Security version configured in Advanced settings:

o WS-Security 1.0

o Lax

o WS-Security 1.1

o Strict

l Endorsing supporting token

n UserNameToken (WssUsernameToken10) included always to recipient.

o Only PasswordText token type is supported.

Prerequisites:

l Create a Virtual Service. See "How to Create a Virtual Service" on page 16

l Credential Storemust contain an identity with each user and password used to authenticate to
the real service.

To configure UserNameOverTransport:

1. Check Enabled inMessage Security.

2. Select UserNameOverTransport inMode.

l Do not configureReal Service Identity orVirtual Service Identity.

Advanced settings for UserNameOverTransport:

l Protection Level – this setting has no effect because encryption and signing is provided by the
transport level (HTTPS).

l Message Protection Order – this setting has no effect because encryption and signing is
provided by the transport level (HTTPS).

l Message Security Version – layout used for security header.

n Message security versions usingWS-Security 1.0 use Lax layout for security header.

n Message security versions usingWS-Security 1.1 use Strict layout for security header.

l Require Derived Keys – this setting has no effect.

l Include Timestamp – this setting controls if requests and responses must contain a security
timestamp.

l Allow Serialized Signing Token on Reply – this setting has no effect.

Configuring MutualCertificate
MutualCertificate is amode with asymmetric security binding (WS-Security 1.0) which uses both
client and server certificates to securemessages over unsecured transport (HTTP):
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l Asymmetric security binding

n Initiator token: X509Token (WssX509V3Token10) included always to recipient.

n Recipient token: X509Token (WssX509V3Token10) never included.

n Algorithm suite: Basic256

n Layout: Strict

n Token inclusion type:

o MustSupportRefKeyIdentifier

o MustSupportRefIssueSerial

Prerequisites:

l Create a Virtual Service. See "How to Create a Virtual Service" on page 16

l Credential Storemust contain an identity with a real service certificate.

n If the certificate doesn’t contain a private key, Credential Storemust also contain an identity
for the virtual service with a certificate containing a private key.

l Credential Storemust contain an identity with each used client certificate.

l Client certificates must contain a private key.

To configure MutualCertificate:

1. Check Enabled inMessage Security.

2. SelectMutualCertificate inMode.

3. Select an identity configured inCredential Store forReal Service Identity.

4. If the identity for the real service doesn’t contain a certificate with a private key or if you want to
use separate identity for the virtual service select an identity configured in Credential Store for
Virtual Service Identity. This identity must contain a certificate with a private key.

Advanced settings for MutualCertificate:

l Protection Level – configures the level of security applied on eachmessage.

l Message Protection Order – configures the order of protection operations used to secure
messages.

l Message Security Version – use only WS-Security 1.0.

l Require Derived Keys – this setting should not be changed.

l Include Timestamp – this setting controls if requests and responses must contain a security
timestamp.

l Allow Serialized Signing Token on Reply – this setting has no effect.

Configuring MutualCertificateDuplex
MutualCertificateDuplex mode with asymmetric security binding (WS-Security 1.0 and 1.1) uses
both client and server certificates to securemessages over unsecured transport (HTTP). The
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difference betweenMutualCertificate andMutualCertificateDuplex is that this security mode also
sends the recipient’s signing token back to the initiator.

l Asymmetric security binding

n Initiator token: X509Token (WssX509V3Token10) included always to recipient.

n Recipient token: X509Token (WssX509V3Token10) included always to initiator.

n Algorithm suite: Basic256

n Layout: Strict

n Token inclusion type depends onWS-Security version configured in Advanced settings:

o WS-Security 1.0

o MustSupportRefKeyIdentifier

o MustSupportRefIssueSerial

o WS-Security 1.1

o MustSupportRefThumbprint / RequireThumbprintReference

Prerequisites:

l Create a Virtual Service. See "How to Create a Virtual Service" on page 16

l Credential Storemust contain an identity with a real service certificate.

n If the certificate contain doesn’t contain a private key, the Credential Storemust also contain
an identity for the virtual service with a certificate containing a private key.

l The Credential Storemust contain an identity with each used client certificate.

l Client certificates must contain private key.

To configure MutualCertificateDuplex:

1. Check Enabled in Message Security.

2. SelectMutualCertificateDuplex inMode.

3. Select an identity configured inCredential Store for Real Service Identity.

4. If the identity for the real service doesn’t contain a certificate with a private key or if you want to
use separate identity for the virtual service select an identity configured inCredential Store
for Virtual Service Identity. This identity must contain a certificate with a private key.

Advanced settings for MutualCertificateDuplex:

l Protection Level – configures the level of security applied on eachmessage.

l Message Protection Order – configures the order of protection operations used to secure
messages.

l Message Security Version – this setting defines how the binary token is referenced in the
request message.
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n Message security versions usingWS-Security 1.0 requires either issuer serial number or key
identifier of the certificate.

n Message security versions usingWS-Security 1.1 requires thumbprint of the certificate.

l Require Derived Keys – this setting should not be changed.

l Include Timestamp – this setting controls if requests and responses must contain a security
timestamp.

l Allow Serialized Signing Token on Reply – this settingmust be checked because the recipient’s
signing token is always send back to an initiator.

How to Set Transport Security
Transport level security is completely handled by the HTTP based agent. The virtual and real
services can use HTTP authentication to prevent unauthorized use. The service can use basic,
digest, NTLM authentication or Mutual HTTPS.

HTTPS and mutual authentication

Services secured with HTTPS are supported by either the HTTPS Gateway agent or the HTTP(S)
Proxy agent. Both agent types also support Mutual HTTPS where the client authenticates itself
with a client certificate. To useMutual HTTPS, the credential storemust contain a client certificate
and its private key for every client accessing the virtual service. See How to Set Authentication
Credentials.

HTTP authentication over HTTP(S) Proxy agent

When using a proxy agent and running the virtual service in pass through (stand-by) or recording
mode, the authentication is fully transparent and the virtual service doesn’t need any further
configuration. The entire security handshake is passed from the client to the real service through
the proxy and client credentials are validated just by the real service.

HTTP authentication is not used when the service is in simulatingmode.

HTTP authentication over HTTP / HTTPS Gateway agent

When using the gateway agent and running the virtual service in pass through (stand-by) or
recordingmode, the client authenticates to the virtual service and the virtual service authenticates
to the real service. The virtual servicemust be able to validate a client’s credentials and pass them
to the real service, meaning that the servicemust have all user names and passwords in the
credential store.

There are several steps to set this authentication:

1. All users who are authenticating to your servicemust be present in theWindows system where
the virtual service is running. They can be added as local users of themachine or added to the
domain to which the computer belongs. The username and passwordmust be the same as the
one the client uses to authenticate to the real service.

Note: HTTP digest authentication only works with domain users, not local ones. The domain
must have reversibly encrypted passwords. See IIS documentation for details.

2. To delegate requests to the real service (when learning or in stand-by mode), the username and

HP Service Virtualization (2.10)Page 91 of 105



User Guide
Chapter 8: Security

passwordmust be in the service's credential store.

a. From the Virtual Service Editor, open the Security Settings and click Edit Credential
Store.

b. Click Add Identity.

c. Enter Identity details and supply a certificate if required.

d. Click OK to add the identity andOK again to close the Credential Store.

Note: When using HTTP Basic authentication, credentials missing in the credential store are
automatically detected and can be simply added via the Fix It command in the Problem
List.

HTTP authentication is not used when the service is in simulatingmode.

Windows accounts for HTTP authentication

Basic, digest and NTLM authentication in the HTTP / HTTPS Gateway agent is supported only with
Windows accounts:

1. If the computer running Service Virtualization is in the same domain as the service host, make
sure the domain users are able to log on to themachine the application is running on. The
virtual service authenticates against the same users as the real one.

2. If machines cannot be placed in the same domain, create local windows or domain user
accounts (domain users still need to be able to log on themachine the application is running on)
with the same names that the client is using to authenticate to the service.

Note: If you would like to use the HTTP Digest authentication, use only domain user accounts as
local user accounts will not authenticate.
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HP Test Automation Tools Integration
Service Virtualization can be integrated with HP test automation tools. The virtual services are
managed via the tests and the performancemonitors exposed by the virtual services are used by
the performance testing tools.

Virtual services must be deployed to the Service Virtualization Server for this integration. For
details, see "HP Service Virtualization Server" in the installation guide.

Service Virtualization integrates with Service Test 11.20, Load Runner 11.00 and Performance
Center 11 with latest patches.

This chapter includes:

Service Test 94

Performance Center and Load Runner 94
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Service Test
Service virtualization projects can be integrated with HP Service Test (see HP Service Test
documentation). The virtual services are thenmanaged by the test after the integration.

l The simulation start is triggered by the test start.

l Particular data and performancemodels can be selected for the test.

l Simulating orStandby modes using the real service are chosen during the test.

Performance Center and Load Runner
Service virtualization projects can be integrated with the Performance Center or Load Runner
Scenarios (see Performance Center or Load Runner Documentation). The virtual services are then
managed by the test after the integration.
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l The simulation start is triggered by the test start.

l Specific data and performancemodels can be selected for the test.

l Simulating orStandby modes using the real service are selected during the test.

Performancemonitors exposed by virtual services are used immediately in the Performance Center
or Load Runner Controller:
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The performancemonitors exposed by Service Virtualization are namedServices andOperations.

l TheServices performance counter provides measurement data per virtual service.

l TheOperations performance counter provides data per virtual service and service operation.
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Troubleshooting
This chapter includes:

Runtime View 98

HTTPS Client Connection Aborted 98

Configuring HTTP Proxy on Clients 98

Setting HTTP Proxy in Designer 101
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Runtime View
Runtime view doesn't respect selected data model when changing mode.

Problem: User chooses a simulationmodel in the Service Editor and starts a new
learning/simulation from the Runtime View. Instead of using the new simulation, the simulation
model from the previous learning/simulation is used again.

Solution: Runtime View is used just to change servicemodes, not configurations. To change the
simulationmodel, open the Service Editor, select a new simulationmodel and start a new
learning/simulation from the Service Editor.

Cannot start learning service 'My Service'.

Problem: Real Datamodel or Performancemodel must be selected in service configuration.

Solution: This error may happen when all data and performancemodels are deleted from the
service configuration and the user tries to start a new learning/simulation session from the Runtime
View. To solve the problem, create a new Data/PerformanceModel and start a new
learning/simulation session from the Service Editor.

HTTPS Client Connection Aborted
Problem: The client connection to a virtualized service deployed on an HTTPS endpoint is aborted
with the error message SSL_ERROR_RX_RECORD_TOO_LONG when Service Virtualization is
running on aWindows XP orWindows 2003machine. The client is normally able to connect to a
real service without any issue.

Solution: See http://support.microsoft.com/default.aspx?scid=kb;EN-US;933430 for a list of
possible solutions. ForWindows 2003, any workaroundmethod as described in the Knowledge
Base article can be used, however, only the first or secondmethods work withWindows XP.

Configuring HTTP Proxy on Clients
Problem: A virtual service is created on a proxy agent and the user is unable to recordmessages.

Solution:Configure the HTTP Proxy on clients.

All examples below of specific client configurations are using the proxy serverHTTP Proxy Agent
listening on address hostname with port 6071.

HTTP Proxy in .Net Client

The .Net client can be configured to use a default proxy server or a specific proxy server.

If using the default proxy server takeHTTP Proxy Agent settings to configure the default proxy
server. This is done inMSWindows or Internet Explorer in Internet Properties > Connections >
LAN settings > Proxy server. The client thenmust be configured to use the default proxy. This is
set in application configuration file either for application in element <defaultProxy>:

<configuration>

<system.net>

<defaultProxy enabled="true">
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<proxy usesystemdefault="true"/>

</defaultProxy>

</system.net>

</configuration>

, or for a specific binding in a binding element:

<configuration>

<system.serviceModel>

<bindings>

<basicHttpBinding>

<binding name="myHttpBinding" bypassProxyOnLocal="false"

useDefaultWebProxy="true">

</binding>

</basicHttpBinding>

</bindings>

</system.serviceModel>

</configuration>

The same configuration file can be used to set a specific proxy server. This is an example of client
configuration for application:

<configuration>

<system.net>

<defaultProxy enabled="true">

<proxy proxyaddress="http://hostname:6071"/>

</defaultProxy>

</system.net>

</configuration>

, or for specific binding:

<configuration>

<system.serviceModel>

<bindings>

<basicHttpBinding>

<binding name="myHttpBinding" bypassProxyOnLocal="false"

useDefaultWebProxy="false" proxyAddress=" http://hostname:6071">

</binding>

</basicHttpBinding>
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</bindings>

</system.serviceModel>

</configuration>

HTTP Proxy in Java Client

The proxy settings for Java client are given to the JVM via command line arguments. This is
example of how to run client from command line with proxy configuration:

java -Dhttp.proxyHost=hostname -Dhttp.proxyPort=6071 MyJavaClient

HTTP Proxy in WebLogic

Add the Java proxy parameters to Java options in JAVA_OPTIONS environment variable in the
proper section of script %WL_HOME%\common\bin\commEnv.cmd for MSWindows or in
${WL_HOME}/common/bin/commEnv.sh for Unix/Linux. This is example of setting proxy
configuration in file commEnv.cmd (MSWindows):

set JAVA_OPTIONS=%JAVA_OPTIONS% -Dhttp.proxyHost=hostname -

Dhttp.proxyPort=6071

, or in file commEnv.sh (Unix/Linux):

JAVA_OPTIONS="${JAVA_OPTIONS} -Dhttp.proxyHost=hostname -

Dhttp.proxyPort=6071

HTTP Proxy in WebSphere

The HTTP proxy on theWebSphere application server can be configured via setting transport
properties http.proxyHost and http.proxyPort. These HTTP transport properties can be
set via:

1. Using wsadmin.

2. Using an assembly tool.

3. Using the JVM custom property panel in the administrative console.

To learnmore about (1) and (2), see theConfiguring additional HTTP transport properties
documentation inWebSphere. To configure the HTTP proxy properties using (3) use the
administrative console with the following steps:

1. Open the administrative console.

2. Click Servers > Application Servers > server > Java and Process Management >
Process definition > Java Virtual Machine > Custom Properties.

3. (Optional) If the property is not listed, create a new property name.

4. Enter the name http.proxyHost and value hostname.

5. Enter the name http.proxyPort and value 6071.

6. Restart the server.

HTTP Proxy in JBoss

Add the Java proxy parameters to Java options in JAVA_OPTS environment variable in the startup
script %JBOSS_HOME%\bin\run.bat or run.conf.bat for MSWindows or in ${JBOSS_
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HOME}/bin/run.sh or run.conf for Unix/Linux. This is an example of setting the proxy
configuration in JAVA_OPTS environment variable in file run.conf.bat (MSWindows):

set "JAVA_OPTS=-Dhttp.proxyHost=hostname -Dhttp.proxyPort=6071

, or in file run.conf (Unix/Linux):

JAVA_OPTS="-Dhttp.proxyHost=hostname -Dhttp.proxyPort=6071

Setting HTTP Proxy in Designer
Problem:User is unable to access any remoteWSDL or Service Virtualization Server.

Solution:Proxy setting needs to be configured in Designer.

How to Set HTTP Proxy in Designer

In some cases Service Virtualization Designer communicates with external services using the
HTTP protocol. The first case is the communication with Service Virtualization Server, where the
service is the server management API. The second case is the import of the a real serviceWSDL.
In some situations, the Designer’s HTTP communicationmust be forwarded through an external
HTTP Proxy. In that situation, the HTTP Proxy settings must be placed in the Designer’s
configuration file.

Note: The setting of HTTP Proxy for agents is not done in the Designer configuration file. See
"Forwarding HTTP(S) Gateway/Proxy Agent Communication through HTTP Proxy" on page
79 for details.

Setting HTTP Proxy in the Designer configuration file

In order to use an external HTTP Proxy for the Designer HTTP communication with a server and
the import of aWSDL from real services, the Designer configuration file must bemodified. This file
is located at
%[INSTALLLOCATION]%\Designer\bin\VirtualServiceDesigner.exe.config.

In the configuration file the element <defaultProxy> holds the HTTP Proxy configuration. This
element is located in the document in elements <configuration><system.net>. By default,
HTTP Proxy is disabled by <defaultProxy enabled="false"/>.

The Designer can be configured to use the system HTTP Proxy or to use a specific HTTP Proxy.
Detailed documentation can be found at http://msdn.microsoft.com/library/kd3cf2ex.aspx. The
Designer must be restarted in order to apply the changes in the configuration file.

System HTTP Proxy

If using the system HTTP Proxy, ensure that the HTTP Proxy is configured in the system. The
settings are available inWindows Internet Explorer® menu Internet Properties > Connections >
LAN settings > Proxy server. The Designer must be configured to use the same proxy in the
configuration file in the element <defaultProxy> like this:

<configuration>

<system.net>

<defaultProxy enabled="true">

<proxy usesystemdefault="true"/>

</defaultProxy>
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</system.net>

</configuration>

Specific HTTP Proxy

If using a specific HTTP Proxy other than the system one, follow this example of Designer
configuration:

<configuration>

<system.net>

<defaultProxy enabled="true">

<proxy proxyaddress="http://foo.com:8080"/>

</defaultProxy>

</system.net>

</configuration>

Setting Credentials for Authenticated HTTP Proxy

If the Designer is configured to use HTTP Proxy with authentication, some additional modifications
may be required in the Designer configuration file. This will allow the supplying of credentials for the
HTTP Proxy. Thesemodifications are required in the case of HTTP communication with the server
management API. In the case of WSDL imports, thesemodifications are only optional as the
Designer will prompt the user for credentials if needed.

In order to set credentials for authenticated HTTP Proxy in the Designer, this sectionmust be
enabled in the configuration file VirtualServiceDesigner.exe.config:

<configuration>

<system.net>

<defaultProxy enabled="true" useDefaultCredentials="false">

<module type =

"HP.SOAQ.ServiceVirtualization.ServerManagementClient.Remote.AuthenticatedProxy,

HP.SV.ServerManagementClient" />

</defaultProxy>

</system.net>

</configuration>

The credentials for the authenticated HTTP Proxy are set in application keys section. Example of
credential settings follows:

<configuration>

<appSettings>

<add key="proxyUserName" value="user1" />

<add key="proxyPassword" value="pass1" />

<add key="proxyAddress" value="http://foo.com:8080" />
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</appSettings>

</configuration>

Where keys are defined as:

proxyUserName User name for authenticated proxy credentials

proxyPassword Password for authenticated proxy credentials

proxyAddress Address of authenticated proxy (e.g. http://foo.com:8080). If this value
is empty then the Proxy Server address in the system proxy is used.

Once the credentials and the proxy settings are configured as described above then the Designer
will use them both for HTTP communication with the server management API andWSDL imports
from real services.
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Service Virtualization Demos
Service Virtualization application demos are installed as an option during the installation process.
The following six demos are included:

Claim Processing Demo

The simulation of a backend SOAP service with limited accessibility in a simple composite
application. The service can optionally use HTTP authentication (see demo readme).

Claim Processing REST Demo

This demo shows a composite application consisting of 2 REST services using JSON and XML
data formats.

Claim Processing Faults Demo

The simulation of a backend SOAP service with limited accessibility in a simple composite
application. The simulated service returns either regular response or one of 3 different SOAP faults.

Claim Processing Security Demo

This demo shows a composite application consisting of 2 SOAP services. It allows demonstrating
how to record and simulate the behavior of one of the SOAP services. Both services authenticate
each other using X509 certificates.

Claim Processing Standalone Server Demo

This demo shows a composite application consisting of 2 SOAP services. It allows demonstrating
how to record and simulate the behavior of one of the SOAP services on a standalone server.

Claim Approval JMS Demo

This demo shows a composite application consisting of 3 SOAP services. It allows demonstrating
how to record and simulate the behavior of two SOAP services. Demo is similar to the Claim
processing service simulation demo. One XML over JMS service (TIBCOEMS approval service)
has been added to the topology here and is being simulated, too.

Claim Approval WebSphere MQ Demo

This demo shows a composite application consisting of 3 SOAP services. It allows demonstrating
how to record and simulate the behavior of two SOAP services. The demo is similar to the Claim
Processing service virtualization demo. One XML overWebSphereMQ service (WebSphereMQ
approval service) has been added to the topology here, and is being simulated, too.

Request Tracking Service Activity Demo

This demo shows a composite application consisting of 4 SOAP services. It allows demonstrating
how to record and simulate the behavior of two SOAP services. In addition, activity can be
demonstrated by calling the third SOAP service from a simulated service.

ShoppingCart - No Sessions Demo
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This demo shows virtualization of stateful shopping cart service, where only one client is using the
stateful service.

ShoppingCart - Sessions by Clients Demo

This demo shows virtualization of stateful shopping cart service, wheremultiple concurrent clients
are using the stateful service and private session is generated for each client.

ShoppingCart - Sessions by Orders

This demo shows virtualization of stateful shopping cart service, wheremultiple concurrent clients
are using the stateful service and sessions are generated per each shopping order. The checkout
operation finishing shopping order destroys the client session (the next operation creates a new
one).
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